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Preparing and Conforming Projects

This chapter provides detailed information about the nuts and bolts of project import, with in-depth 
information about preparing projects for import into DaVinci Resolve, how effects are imported 
and handled, and how to conform XML, AAF, and EDL project exchange formats in the Edit page. 
Additional information is provided about Stereoscopic workflows and copying grades from one 
project or timeline to another using the powerful ColorTrace™ function.
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When you’re preparing to move a project from another NLE to DaVinci Resolve, there are a few 
steps you can take to make your work more organized.

Move Clips to the Lowest Video Track

Increasingly, editors are using the multiple tracks NLEs offer as they build the creative edit of a 
show. While this is convenient for offline editorial, it is less convenient when you’re trying to conform, 
grade, and render the media used by a project as quickly and efficiently as possible.

For this reason, it’s a good idea to move all clips that are not stacked or superimposed as part of 
a compositing operation down to track V1 of the Timeline in your NLE. This produces a simplified 
edit that has many advantages. The project becomes smaller to move because there’s less media 
in the Timeline, and consequently becomes faster to render. Furthermore, the colorist is spared 
confusion because this eliminates “hidden” media that is nonetheless connected to other clips that 
can be seen.

It’s also helpful, once you’ve reorganized the Timeline, to eliminate any empty tracks that are left. 
This can be done from within DaVinci Resolve, but doing it in your NLE further simplifies the project 
import process.

Organize Unsupported Media Files

Depending on your workflow and on the NLE you’re working with, there may be clips that will not 
be supported in DaVinci Resolve. Unsupported generators, unsupported types of title objects, 
unsupported media formats, and other effects constructs may simply not be seen in Resolve, and 
will consequently appear as unlinked clips.

Knowing this in advance, you can move all such clips into dedicated tracks where they can be 
isolated, and the track can be turned off to hide the unsupported clips, simplifying timeline 
navigation. This also saves the colorist from the need to worry about why there are offline clips in 
the Timeline at 3 o’clock in the morning, immediately before starting a render.

Creating an Offline Reference Movie

Even though the colorist in any given workflow is likely to be building new grades from scratch, 
it can be valuable to have a reference movie showing any color corrections, filters, or effects that 
the offline editor applied during the editing process. This offline reference can be imported into a 
Resolve project, and used as a split- screen reference whenever there’s some question about a look 
or effect from the offline edit.

Offline reference movies also serve as a useful tool when conforming a project in the Edit page. After 
project conform, you can compare the project as seen in the Record Viewer with the synchronized 
offline movie as seen in the Source Viewer set to Offline mode. This makes it easy to scrub through 
a project to make sure that each clip has imported correctly and is in sync.

Preparing Your Project for Color Correction
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Mixed Frame Sizes and Mixed Codecs

Most NLEs can freely mix media using different frame sizes, different codecs, and different frame 
rates. DaVinci Resolve deals with these combinations in different ways, depending on what settings 
you’ve selected in the Project Settings.

 >Mixing Frame Sizes: Mixed frame sizes are easily handled. The Set Timeline Resolution To 
parameter in the Master Project Settings panel of the Project Settings dictates the current 
resolution of the project. Any clips with a frame size that doesn’t match the project is resized 
according to the option selected in the Image Scaling panel of the Project Settings. You 
can, of course, always manually readjust the sizing of any clip if you want to make a specific 
adjustment. All resizing is done using the optical-quality resizing algorithms in DaVinci 
Resolve. For more information, see Chapter 6, “2D Transforms.”

 >Mixing Codecs: Mixed codecs are also not a problem, as long as the different codecs used 
by the media in your project are compatible with the list of codecs and formats that DaVinci 
Resolve supports. For more information about the currently supported list of codecs and 
formats, check the Blackmagic Design support page for DaVinci Resolve. This list is updated 
often with newly supported formats.

Mixing Frame Rates

DaVinci Resolve also supports mixed frame rates, although there are a variety of settings you must 
choose to ensure the best results. By default, mixed clip frame rate support is enabled via the 
“Mixed frame rate format” pop-up menu that appears either in the Master Project Settings, or in 
the Import AAF or XML dialog. 

The different options available in the “Mixed frame rate format” pop-up are available to let you 
conform projects using the method of mixed frame rate calculation used by the NLE a project was 
originally edited in; different NLEs have different ways of mixing frame rates, and that used by Final 
Cut Pro 7 is different from that used by Final Cut Pro X or Avid Media Composer. If you need to 
change this setting, you must do so before you import any media into the Media Pool; once the 
Media Pool is populated, this setting can no longer be changed.

Mixed frame rate format selection
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This Mixed frame rate format pop-up menu is also found in the Load AAF and Load XML dialogs. 
Resolve automatically chooses a setting from the “Mixed frame rate format” pop-up menu that 
corresponds to the project file you’re importing, but you can override this setting if necessary. For 
projects sent from Final Cut Pro, you can choose either “Final Cut Pro 7” or “Final Cut Pro X” to 
match the type of project you’re importing. On the other hand, you should choose “Resolve” for 
projects imported from Premiere Pro, Smoke, Media Composer, or other NLEs.

When “Mixed frame rate format” is set to anything but None, DaVinci Resolve conforms and 
processes all clips in the Timeline to play at the frame rate that’s selected in the “Calculate Timecode 
At” pop-up menu. For example, 23.98, 29.97, 30, 50, 59.94 and 60 fps clips will all play at 24 fps if 
that’s what “Timeline frame rate” is set to in the Master Project Settings. Clips with different source 
frame rates will be retimed to match the timeline conform frame rate. 

The Retime process that’s used to render clips with differing frame rates can be changed for 
individual clips via the Retime Process parameter in the Inspector, or it can be changed project-
wide using the Retime Process parameter found in the Editing panel of the Project Settings. For 
more information on how each of the three available options work, see the “Frame Interpolation” 
section of Chapter 2, “Project Manager and Settings.” 

If you choose “None,” then clips with mixed frame rates will ignore their original frame rate and will 
play at the timeline rate, resulting in either faster or slower motion, depending on the difference 
between the original and timeline frame rates.

Note: Because DPX files often either lack or have incorrect frame rate information in the header 
data, you may need to select None when conforming a project using image sequences to make 
sure your media is not incorrectly interpreted.

How clips in mixed frame rate timelines are rendered depends on whether the Render Settings are 
set to render individual source clips or one single clip. When you render the Timeline as ”Individual 
Source Clips,” then all clips are rendered individually at their original frame rate. If you select ”Single 
Clip,” then all clips are converted to the “Timeline frame rate” frame rate setting, and rendered as 
a single media file.
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Importing Effects When Conforming Edits

DaVinci Resolve is capable of translating a subset of the effects exported within XML, AAF, and 
EDL project files into their Resolve equivalents. The following chart illustrates which effects are 
supported, and for which project import formats.

Unsupported effects are neither imported nor displayed in Resolve. However, the majority of 
unsupported effects are preserved internally, and are reinserted into exported XML or AAF files so 
that those effects will reappear in your NLE once the project is reimported.

EDL FCP 7 XML FCP X XML AAF

Color Corrections No No Yes No

Composite Modes No Yes Yes Overlay only

Multiple Tracks No Yes Yes Yes

Transitions Yes Yes Yes Yes

Opacity Settings No Yes Yes
Yes, via 3D Warp 
or Superimpose

Position, Scale, Rotation No Yes Yes Yes, via 3D Warp

Linear Speed Effects Yes Yes Yes Yes

Variable Speed Effects No Yes Yes Yes

Still Image Clips No
.tif, .jpg,  

.bmp, .dpx, 
.dng, .psd

.tif, .jpg,  
.bmp, .dpx, 
.dng, .psd

.tif, .jpg,  
.bmp, .dpx, 
.dng, .psd

Freeze Frames No No No Yes

Nested Sequences No Yes Yes No

Linked Clip Audio Yes Yes Yes Yes

Mixed Frame Rates No Yes Yes Yes

Text Generators No Yes Yes No

Effects supported with imported AAF, XML and EDL
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About Supported Color Corrections

At the time of this writing, only Final Cut Pro X XML projects are capable of exporting color 
correction data that can be imported as primary grades in DaVinci Resolve. For obvious reasons, 
color correction import is a one-way street, and imported color corrections cannot be output 
back to Final Cut Pro. Imported Final Cut Pro X color adjustments appear in the Color page as 
primary corrections.

Other workflows for importing color correction information are available using ColorTrace to import 
grade data from CDLs. For more information, see the “Copying Grades Using ColorTrace” section 
later in this chapter.

About Supported Transitions

EDLs are the most restrictive when it comes to transition support in Resolve, as only Cross Dissolves 
will be read. Any other transitions appearing in an EDL will be automatically converted to a Cross 
Dissolve of the same duration when it’s imported into DaVinci Resolve.

On the other hand, Resolve supports the import of ten different transitions when importing XML 
project files from Final Cut Pro 7 and Final Cut Pro X, or nine different transitions when importing 
AAF files from Avid Media Composer or Symphony.

EDL FCP XML AAF

Clock Wipe No Yes Yes

Center Wipe No Yes Yes

Cross Dissolve Yes Yes Yes

Additive Dissolve No Yes No

Dip to Color Dissolve No Yes Yes

Edge Wipe No Yes Yes

Venetian Blind Wipe No Yes Yes

Cross Iris No Yes Yes

Diamond Iris No Yes Yes

Oval Iris No Yes Yes

Supported transitions for imported EDL, XML and AAF
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Transition Names

To help you prepare projects for export, note that the names of transitions vary between XML 
and AAF project files. Here are the supported transitions as they appear in Avid Media Composer 
and Symphony.

 > Dip to Color Dissolve = Dip to Color effect in the Blend category

 > Edge Wipe = Horizontal/Vertical/Lower Left/Lower Right/Upper Left/Upper Right Diagonal 
effects in the Edge Wipe category

 > Center Wipe = Horizontal Open and Vertical Open effects in the Edge Wipe category

 > Clock Wipe = Clock effect in the Shape Wipe category

 > Venetian Blind Wipe = Vertical Blinds and Horizontal Blinds effects in the Shape Wipe category 

 > Cross Iris = 4 Corners effect in the Shape Wipe category

 > Diamond Iris = Diamond effect in the Shape Wipe category 

 >Oval Iris = Circle effect in the Shape Wipe category

About Supported Opacity, Position, Scale, and Rotation Settings

DaVinci Resolve supports the import of Opacity, Position, Scale, and Rotation settings when 
importing XML project files from both Final Cut Pro 7 and Final Cut Pro X. Imported Composite and 
Transform settings for any given clip appear in the Inspector of the Edit page, or in the Edit Sizing 
mode of the Sizing palette in the Color page. If these settings have been keyframed, the animation 
will appear in DaVinci Resolve.

DaVinci Resolve supports the import of Opacity, Resize and 3D Warp effects when importing AAF 
files from Media Composer or Symphony, which are converted into Pan, Tilt, Zoom, and Rotate 
settings in Resolve. As of Resolve version 11.1, there is also improved support for Bezier and cubic 
interpolated keyframes in AAF files.

About Speed Effects

DaVinci Resolve supports the import of Speed Effects from different applications, but different 
project formats have different Speed Effect support.

 > EDL: Resolve only supports the import of linear Speed Effects when importing EDLs. 

 > XML: Resolve supports the import of both linear and variable Speed Effects when importing 
XML project files from both Final Cut Pro 7 and Final Cut Pro X. In Resolve version 11.1, XML 
from Final Cut Pro X can also provide information about whether frame blending or optical 
flow is used, and also contains information about the Bezier curve transitions of speed effects.

 > AAF: Resolve supports the import of both linear and variable Speed Effects when importing 
AAF files from Media Composer or Symphony that use Timewarp effects.
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About Nested Sequences and Compound Clips

DaVinci Resolve supports the import of nested sequences from Final Cut Pro 7 and of compound 
clips from Final Cut Pro X. Both appear within Resolve as compound clips, in both the Timeline and 
the Media Pool. As of Resolve version 11.1, compound clips with mixed frame rates are supported, 
as well as multi-cam and a/v synchronized clips from Final Cut Pro X, which will be represented in 
Resolve as compound clips. For more information about creating and using compound clips in 
Resolve, see the “Compound Clips” section of Chapter 4, “Edit.”

About Supported Composite Modes

DaVinci Resolve supports the import of eight different Composite modes when importing XML 
project files from both Final Cut Pro 7 and Final Cut Pro X. When importing AAF files from Media 
Composer, the Overlay composite mode is supported when the source AAF file has a Superimpose 
effect applied to it.

About Supported Still Image Formats

DaVinci Resolve supports the import of greater-than-one-frame-in-duration TIF, JPG, PNG, DPX, 
and DNG still image files that appear in Final Cut Pro 7 and Final Cut Pro X XML files, and AAF 
files exported from Media Composer. These clips appear as ordinary clips in the DaVinci Resolve 
Timeline. Export of still images is limited to Final Cut Pro 7 and Final Cut Pro X XML.

FCP 7/X XML AAF

Add Yes No

Subtract Yes No

Difference Yes No

Multiply Yes No

Screen Yes No

Overlay Yes Yes

Lighten Yes No

Hardlight Yes No

Softlight Yes No

Darken Yes No

Supported composite modes with imported XML and AAF 
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About Supported Alpha Channels

Media with embedded alpha channels is supported for any project as long as it’s in a media format 
that DaVinci Resolve supports; this includes TIFF, OpenEXR image sequence formats, and four-
channel QuickTime formats such as ProRes 4444. Alpha channels are automatically enabled, and 
can be used for compositing directly within the Resolve Timeline.

While alpha channels can be imported into Resolve, and can be used to composite layers in a 
timeline, alpha channels cannot be exported along with clips in round-trip workflows when rendering 
individual source clips. However, when rendering a program as a single clip, all composited effects 
are rendered together to produce a single output media file.

About Imported Text Effects

DaVinci Resolve supports the import of text generators when importing XML project files from both 
Final Cut Pro 7 and Final Cut Pro X. All imported text effects appear in the DaVinci Resolve Timeline 
as Basic text generators. Some, but not all, formatting parameters are imported, depending on the 
project file format being imported.
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Preparing Unsupported Clips and Effects You Want to Grade

If there is an unsupported effect within your NLE of choice that you want to move into DaVinci 
Resolve for grading (for example, clips with effects filters that are native to a particular NLE), here’s 
a simple workflow to follow.

To “bake” an effect into a clip you’re sending to DaVinci Resolve:

1. Export that clip as a self-contained media file using whatever Resolve-compatible mastering 
codec you prefer.

2. Reimport the resulting media file into your project.

3. Edit it into your project’s timeline to replace the original effects clip.

4. Export a version of the resulting sequence for use in Resolve.

This is a good way of prepping the titles and effects of projects that you want to finish in DaVinci 
Resolve. If you create self-contained media files for all title clips and effects, then these elements 
will import cleanly and easily, and you can export a complete, texted version of your program out 
of Resolve.

Additionally, if a composited clip is using unsupported effects (for example, a filtered still image 
with animated position that’s superimposed using the Overlay composite mode and set to 70% 
opacity), an ideal way to prep this clip for XML export to Resolve is to set the composite mode 
to Normal, set Opacity to 100%, and then export the resulting clip as a self-contained QuickTime 
movie. Reimport the result, edit it back into the Timeline to replace the original superimposed clip, 
and then set its composite mode to Overlay and its Opacity to 70% to match the original settings. 
Now the unsupported effects are “baked” into the clip, but the effects that Resolve does support 
are still live, and can be readjusted in context while grading.
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Rules for Conforming Media in DaVinci Resolve

When conforming projects in Resolve, the accuracy and integrity of your clip metadata is critical for 
a successful result. Keep the following three issues in mind when you’re preparing media to use in 
DaVinci Resolve.

 > Accurate timecode: Essential for every clip. If you have problems with your timecode, Resolve 
has tools you can use to edit or offset timecode to account for known inconsistencies. By 
default, the “Use Timecode” project setting is set to “Embedded in the Source Clip,” so 
that timecode is read from the embedded timecode track within a QuickTime or MXF file, 
or from the header data of a DPX frame file. However, you can also choose the “From the 
source clip frame count” option which enables timecode to be read from the Source clip’s 
frame count for image sequences.

 > Reel Name: Only used for conforming if “Assist using Reel Names” is on in the Master 
Project Settings panel of the Project Settings. Assigning reel names to your media is 
not essential, but recommended, and can make media management easier for certain 
operations. However, if you experience problems conforming clips with “Assist using Reel 
Names” turned on, you should try turning it off.

 > File names: Turning “Assist using Reel Names” off forces Resolve to refer to clips using file 
names when conforming XML and AAF projects. File names can only be only used when 
conforming XML or AAF files, or when importing a DaVinci project; file names are never 
used when conforming EDLs.

How DaVinci Resolve matches media files to clips in an imported project depends on how you’re 
importing the project.

Defining Clip Metadata When Importing XML and AAF

For workflows where you’re importing XML or AAF projects, and conforming the resulting clips 
in Resolve to media files that are either on disk or in the Media Pool already, the rules for how clip 
metadata is defined depend on two settings in the Load XML or EDL dialog: “Automatically Import 
source clips into media pool,” and “Ignore file extensions when matching.”

The ways in which these two checkboxes interact to let you choose how media is conformed to an 
imported AAF or XML file are complex, but here are the rules.

The most important settings for conforming media in the Load dialog
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Importing Clips With File Extensions Matching Those in the AAF or XML File

Turn “Automatically Import” on and “Ignore file extensions” off.

This is the default setting, and is most useful when the AAF or XML file you’re importing contains 
references to the high-quality media you want to grade, and you want to automatically add it to the 
Media Pool.

 > First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching the file paths in the XML or AAF to the stored file paths of 
each clip in the Media Pool. 

 > Second, for all remaining clips not found, Resolve imports as many clips as possible into the 
Media Pool from any storage volumes that are visible to Resolve, using the file paths from 
the XML or AAF.

 > Third, for all remaining clips not found, Resolve tries a clip name match of clips that are 
already in the Media Pool.

 > Fourth, for all remaining clips not found, Resolve tries a timecode match (along with a reel 
name match if this is enabled) of clips that are already in the Media Pool.

 > Finally, for all remaining clips not found, the user is prompted to manually choose another 
folder to search.

Importing Clips With Different File Extensions

Turn “Automatically Import” on and “Ignore file extensions” on.

Turning both of these options on is useful in situations where the sequence you’re importing was 
originally edited using offline quality media, and you want to conform to high-quality online media in 
a completely different format, possibly in the Media Pool, possibly on another disk. One example of 
this is as when the edit was done using QuickTime or Avid DNxHD media, but you’re reconforming 
to CinemaDNG files on another disk in order to grade the camera original raw media. Leaving 
“Automatically Import source clips into media pool” on, in this case.

 > First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching clip names.

 > Second, for all remaining clips not found, the user is prompted to choose another folder to 
search, and Resolve imports as many clips as possible by matching clip names.

 > Third, for all remaining clips not found, Resolve tries a timecode match (and reel name 
match if this is enabled) of clips that are already within the Media Pool.

 > Fourth, for all remaining clips not found, the user is prompted to manually choose another 
folder to search.
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Don’t Import Any Clips, Relink to Clips In the Media Pool Only

Turn “Automatically Import” off.

Turning “Automatically Import source clips into media pool” off is useful in situations where you 
only want to conform the imported AAF or XML to clips in the Media Pool. This is most useful in 
situations where you’ve imported all of the camera original media into the Media Pool first, for 
example when creating the dailies that were then edited, and you want to conform the imported 
AAF or XML to the media that’s already there.

 > First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching the file paths in the XML or AAF to the file paths stored for 
each clip in the Media Pool.

 > Second, for all remaining clips not found, Resolve tries a clip name match of clips that are 
already in the Media Pool.

 > Third, for all remaining clips not found, Resolve tries a timecode match (and reel name 
match if this is enabled) of clips that are already within the Media Pool. In this case, the file 
name is not used.

Beware When Choosing a Volume or Folder to Search

You can choose an entire volume when relinking, and eventually all media on that volume will be 
found. However, depending on the size and number of files on the selected volume, this operation 
could take a very, very long time.

Defining Clip Metadata When Adding Media to the Media Pool

For workflows where you’re manually adding media files to the Media Pool when you’re processing 
dailies, or as a separate step before importing EDL, XML, or AAF project files and reconforming 
them to a higher-quality set of media, the rules for how clip metadata is defined are a bit different.

 > Timecode: Calculated using the “Calculate Timecode At” setting in the Master Project 
Settings panel of the Project Settings.

 > Reel Names: Determined depending on whether the “Assist using Reel Names from the” 
checkbox is on or off, and on which option you’ve selected. Reel names are extracted 
dynamically, so any time you change this setting the reel names in the Media Pool update 
to reflect the change.

 > Clip Names: Read and stored, but not used for imported EDLs.
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How Reel Names are Identified

The “Assist using Reel Names” checkbox in the Master Project Settings panel of the Project Settings 
is an extremely important setting for controlling how the conform process works. As previously 
mentioned, reel names are extracted dynamically, so any time you change this setting the reel 
names in the Media Pool update to reflect the change.

There are four options that are available for determining how reel names are extracted from the 
source media when this setting is turned on.

 > Source clip file pathname: Obtains the reel name by extracting it from each media file’s 
path. This makes it possible to extract a reel name from all or part of the file name, or from 
all or part of the name of any folder in the path that encloses that file. This extraction is 
defined using the Pattern field.

 > Pattern: A code that defines how a reel name should be extracted from the source clip 
pathname. More information about creating patters appears later in this chapter.

 >Media Pool folder name: The reel name is obtained from the name of the bin in the 
Media Pool that encloses that clip. For example, in a stereoscopic workflow you might 
want to export offline stereo media with the “Left” and “Right” bin names in which they’re 
organized as reel names. Another example would be organizing VFX being incrementally 
processed in individually named bins, such as “VFX_Tuesday_10-12.”

 > Embedding in Source clip file: Useful for file formats where the reel name is embedded 
within the media file itself. CinemaDNG and other digital cinema cameras, QuickTime  
files created by Final Cut Pro, and DPX frame files are formats that can contain reel name 
header data.

 > Source clip filename: If there is no defined reel number, often it’s easy to just use the Source 
clip filename.

An additional checkbox is available, “Extract reel names from EDL comments,” which is primarily 
useful when conforming EDLs exported from Final Cut Pro 7 to R3D media.

 > Extract reel names from EDL comments: Some media file formats, such as R3D, have reel 
names, obtained from the file names, that are longer than the eight characters that are 
allowable in a standard EDL. This option allows DaVinci Resolve to extract reel names from 
appropriately formatted EDL comments, such as those output from Final Cut Pro 7.

Using the Pattern Field

If you’re using the Pattern option to extract the reel name from a clip’s source file pathname, you 
have the option to create your own search pattern, enabling you to have DaVinci Resolve extract the 
reel name for more exotic workflows.
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Extraction patterns are interpreted from right to left, deciphering each clip’s file path starting with 
the file name, and then considering each enclosing directory’s name to the left. Each extraction 
pattern consists of a series of text characters and “wild card” operators in unique combinations 
corresponding to the length and names used in the file path.

Here are a series of search characters that may be used.

If you’re trying to create a new extraction pattern for a unique workflow, there’s a test dialog you can 
use to try different patterns out before applying them to your project.

To test the extraction path:

1. Click the Test button next to the current Pattern in the Master Project Settings panel of the 
Project Settings. The “Specify Reel Extraction Pattern” dialog opens.

2. Type the extraction patten you want to test into the Pattern field. 

3. Using whatever method you prefer, find the file path of the media file that you want to test the 
extraction pattern on, and copy or type it into the Sample Path field. 

4. Click TEST. 

5. If the reel name that appears below is correct, then click Apply to copy the extraction pattern 
into the Pattern field of the Master Project Settings. If the reel name that appears is not correct, 
modify the extraction pattern and try again.

Extraction Pattern Operators

?
Looks for matches of any single character. Add as many question marks as there are 
characters you want to match. ?? matches two characters such as 02, ???? matches 

four characters such as 0002.

* A wildcard that creates matches for any sequence of zero or more characters.

%R
Specifies the reel name’s actual location. Reel names may contain any character, but 

should not contain a directory separator (forward slash).

%_R
Extracts the reel name and strips out the R3D file name underscores found in EDLs 

from Final Cut Pro 7 or earlier.

%D
Matches any directory name or file name. When this is the last operator in a pattern, 

do not add a forward slash.

/ Used to separate any two operators
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Examples of Reel Name Extraction Patterns

To better understand how this process works, below are several examples showing the various 
methods of reel name extractions. The / is used as the separator between control parameters.

Example 1: 

This example shows the reel name stored within the parent folder name of the clip..

 > Pattern: */%R/%D

 > File path: vol0/MyMovie/Scans/004B/Frame[1000-2000].dpx

 > Reel Name: 004B

Parsing takes place from right to left so to analyze this pattern start at the right end. In this case the 
%D matches to the file name “FrameNNNN.dpx” where NNNN is the frame number in each file of 
the clip. Moving left of the file name, the /%R/ section of the string is next. This specifies that the 
reel name will be the entire name of the parent directory immediately above the file. Then the * at 
the beginning of the string says match any pathname in front of the directory name that has the reel 
name. This string would find the parent directory regardless of how many levels deep it is nested 
on the directory path.

Example 2: 

Here we see the reel name stored in the parent folder name of the clip and prefixed with the  
reel name. 

 > Pattern: */????%R/%D or alternatively */Reel%R/%D

 > File path: /vol0/MyMovie/Scans/Reel1234/Frame[1000-2000].dpx

 > Reel Name: 1234

In this example both of these extraction patterns produce the same result. They are also similar to 
the first example. The reel name is still in the parent directory name but in this case it will have the 
fixed characters “Reel” prefixed in front of the reel name. The first pattern with ???? would actually 
match with any 4 character in front of the reel name. The second pattern is more specific and would 
only match the word “Reel” in the directory name.

Example 3:

This example shows the reel name stored within the parent folder name two directory levels up. 

 > Pattern: */%R/%D/%D

 > File path: /vol0/MyMovie/Scans/004B/134500-135000/Frame[1000-2000].dpx

 > Reel Name: 004B
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This example is again similar to Example 1. The difference is that in Example 3, the reel name is the 
directory name two levels above the clip. In Example 1, the reel name was in the directory name 
only one level up.

Example 4:

Finally, we see the reel name that is embedded within the clip name of the material. 

 > Pattern: */Reel%R_*

 > File path: /vol0/MyMovie/Scans/Reel004B_[1000-2000].dpx

 > Reel Name: 004B

This example shows a method for extracting the reel name from the file name of the clip. Again, 
starting at the right the two pattern characters “_*” match any series of characters up to the first 
underscore character. In this case it will pick up the file extension (.dpx) and the frame number 
portion of the file name. Next, the “/Reel%R” characters indicate the reel name is the characters 
between the ‘/Reel” and _ character. The * at the beginning of the pattern will match a file path any 
number of directories deep in front of the file name.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

385

PREPARING AND CONFORMING PROJECTS9

If you’ve been given an enormous amount of source media to conform to, you may be hesitant to 
copy all of it to your accelerated storage, since (a) most of it is likely unused by the project file you’ve 
been given, (b) it’ll take forever to copy, and (c) it will clog up your local storage, taking valuable 
space away from other projects. In this case, you can use the Consolidate command to copy a 
reduced set of media files consisting of only the clips used in the current Timeline of the Edit page. 

But the Consolidate command isn’t just useful for projects you’re bringing in from other sources. If 
you’ve edited a program within DaVinci Resolve, you can use the Consolidate command to bundle 
the media used by a particular Timeline in preparation for handing it off to another Resolve user, or 
to someone employing a completely different NLE or finishing application. 

No matter what you use if for, the Consolidate command has been expanded to work with 
QuickTime, MXF, R3D, and Image Sequences (including CinemaDNG media), making it useful for 
media management of all kinds of projects.

To use Consolidate to create a consolidated duplicate of media in a timeline:

1. Connect the hard drive containing the media to be conformed to your workstation.

2. Import the edited project file, as an EDL, AAF, or XML file, into the Edit page, and conform 
it to the media on whatever portable storage media you’ve been given, as usual. You’re only 
doing this to identify what clips you need to consolidate, not because you’ll be working off 
that volume.

3. Manually select the clips in the current Timeline that you want to consolidate to your accelerated 
volume. If this includes the entire Timeline, you can press Command-A to select all clips.

 Tip: If there’s a specific range of the current Timeline you want to select, you can also press 
Shift-Z to fit every clip in your program into the current width of the Timeline, and then drag a 
bounding box to select as large a portion of the Timeline as you need.

4. Now, right-click any one of the selected clips, and choose Consolidate.

5. In the file dialog that appears, choose the appropriate settings for how you want to consolidate 
the media.

Consolidate Media
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 > Trim to: Click the button to the right of the Trim to field to choose a destination to which 
to copy the consolidated media. To create a new directory, right-click a Volume icon in the 
File Browser list, choose New Folder, type a name into the resulting dialog, and click OK.

 > Use source clip full extents: Forces this operation to copy the full amount of source media 
corresponding to each selected clip in the Timeline, without omitting unused extents 
before or after the In and Out points of each selected clip. Use when you simply want to 
make a complete duplicate of all source media referenced by the current Timeline selection.

 > Consolidate multi-edit extents: If multiple clips in the selection come from a single media 
file, then a single consolidated media file will be generated that contains all frames from 
each of these clips, along with whatever additional frames lie between them. Even though 
this option results in more media being copied, it’s extremely useful if you’re consolidating 
media that you want to grade using remote versions with automatic linking, as each clip’s 
original relationship to the source media file it’s from is preserved.

 > Add handles: Adds additional frames of media to the head and tail of each trimmed clip.

 > Preserve levels after head: Retains a user-specified depth of the original directory structure 
used by a clip’s corresponding source media file, recreating it when rendering new files for 
output. The number you select determines how many levels of subdirectories Resolve will 
automatically create within the currently specified “Render job to” directory to match the 
path used by the source files. Defaults to 0, which creates no matching subdirectories. The 
number of path levels is defined relative to the head of each media file path.

 > Preserved path: Shows you a preview of the file path that will be written by this operation.

 All selected media is copied to the specified directory in the manner you’ve selected. At this 
point, you can relink the current Timeline to the new media in the next step.

6.  Right-click anywhere in the Media Pool and choose Remove All Clips in Bin. This empties out 
the Media Pool, and the clips in the conformed timeline go offline.

The Consolidate dialog lets you choose how and where to copy the trimmed media
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 Note: You can only remove all clips so long as the Master Timeline (if there is one) is not what’s 
currently selected.

7. Now, open the Timelines browser, then right-click the conformed Timeline you’re working on, 
choose Import > Additional Clips With Tight Filename Match, and then choose the directory 
to which you copied the trimmed media in step 5.

 The consolidated media now populates the Media Pool, and the clips in the selected timeline 
are automatically reconformed to the new media. You are now ready to grade the project.

Using Consolidate Multi-Edit Extents and Preserve Levels  
After Head Together

When the “Consolidate multi-edit extents” checkbox is off and “Preserve levels after head” is 
left at the default of 0, timelines that use multiple clips derived from the same media file generate 
multiple trimmed media files. Each of these newly generated media files are renamed with an 
additional number; examples include _0, _1 for DPX files, _S000.RDC, _S001.RDC for R3D files, and 
_S000.mov, _S001.mov for QT media, etcetera. 

If the “Consolidate multi-edit extents” checkbox is off, and “Preserve levels after head” is set to a 
value of 1 or more, then the results will be different. For DPX media, all consolidated frames appear 
in the same folder. For R3D and QuickTime/MXF media, the original file name will be used for each 
consolidated clip that is derived from a particular media file, and each previously consolidated clip 
from that file will be silently overwritten by the next.
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If you need to color correct a project that was edited elsewhere, the Edit page can be used to 
import projects from other applications via the EDL, AAF, or XML project exchange formats, and 
conform them to the high-quality media you want to grade. When you go through the process of 
conforming a project, you use the imported project data to arrange the clips in the Media Pool into 
a timeline that constitutes the program that’s about to be graded.

This chapter covers the many conform workflows supported by DaVinci Resolve. For more 
information about the editing capabilities found in the Edit page, see Chapter 4.

It’s because Resolve organizes edited Timelines and the media they use separately that it’s possible 
to import multiple versions of a project using several EDL, AAF, or XML files. The result is a Resolve 
project with multiple Timelines, each having a differently edited arrangement of the same clips, 
each of which can share grades if you’re using remote versions (for more information on versions, 
see Chapter 13, “The Gallery and Grade Management”).

While some project formats make it possible to import a project’s referenced media at the same 
time as its edit data, that just means that the media is automatically placed into the Media Pool, 
instead of you having to put it there yourself. 

In Offline mode, the Edit page can also be used for loading an Offline Reference Clip, which is 
typically a flattened movie output from the original edited sequence. Using an Offline Reference 
Clip, you can confirm that the conformed project in fact matches the original edit in the source NLE. 
Furthermore, you can use an Offline Reference Clip to compare the new color adjustments and 
geometric transforms you’re making against offline effects that were created by the editor.

Conforming Projects
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A common workflow using DaVinci Resolve is the processing of digital dailies for media formats and 
projects where the camera original media would benefit from an initial grade, or from conversion 
into another more workflow-friendly format. Examples include programs shot using Log-C or 
S-Log media that require some form of grading to produce acceptable-looking media for editing, 
or converting processor-intensive raw formats into other high-quality media containers for offline 
editing and/or finishing.

In the process, Resolve offers numerous tools that let you add organizational metadata, synchronize 
dailies in dual-recording workflows, apply processing LUTs for color management, and output a 
wide variety of NLE-friendly media with exactly specified file naming conventions, file structures, 
and timing metadata.

Digital Dailies in a Round Trip Workflow

This section provides an overview of the different features that DaVinci Resolve offers for undertaking 
any workflow that begins with media processing in Resolve.

Step 1—Ingest Media and Add/Edit Metadata

It’s not necessary to have a project file exported from an NLE to start working in Resolve. Using 
the Library browser on the Media page, you can access any volume that’s currently available to the 
system, and import any compatible media format into the Media Pool.

Workflows that Start With DaVinci Resolve

Library with scrubbable clip thumbnails



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

390

PREPARING AND CONFORMING PROJECTS9

The Media Pool is Resolve’s internal database of available media for the currently open project. If 
you like, clips in the Media Pool can be organized into multiple bins. Once media has been added 
to the Media Pool, you can access a variety of descriptive metadata using the Metadata Editor, 
adding descriptions, notes, scene and take information, flags, day and date information, program 
and episode information, etcetera. This data can populate metadata tags when exporting ALE lists 
to move the metadata to a compatible NLE.

For more information on ingesting media in the Media page, see Chapter 3, “Working in the  
Media Page.”

Step 2—Sync Audio to the Dailies

If your video format has embedded audio, Resolve can simply pass that audio through when 
outputting media from the Deliver page. However, if the program you’re working on employs dual-
system audio recording, you can also import timecoded Broadcast WAVE files into the same bin 
as its accompanying video clips (you can place them into a sub-bin if you like), in preparation for 
syncing the dailies in Resolve. Once you’ve imported the video and audio media you want to sync 
into the Media Pool of the Media page, you can right-click the enclosing folder and choose “Auto-
Sync Audio Based on Timecode” which automatically syncs every timecode-matched pair of audio 
and video media clips within the same folder, all at once.

Tip: For the best results, consider using different folders for each day’s audio and video clips.

If there is no timecode relationship between the audio and video clips, you can create manual 
sync relationships by selecting a video clip to open into the Media page viewer, and then change 
the mode of the Audio panel to dailies so you can select the corresponding audio file and see its 
waveform. In this way, you can find the video and audio sync points, and click the Audio panel’s link 
button to lock the A/V sync of that clip.

For more information on syncing audio and video in the Edit page, see Chapter 3, “Media.”

Step 3—Do Whatever Grading is Necessary

Many shoots record a “flat” image to preserve the most image data for grading without clipping 
highlights or shadows. This can be accomplished using in-camera settings that record log-encoded 
QuickTime or MXF media, or via raw video formats that can be debayered as log-encoded video using 
gamma curves such as Log-C, S-Log, S-Log2, S-Log3, BMD Film, or REDlog Film, among others.

The Media Pool
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If you’re outputting high-quality media files meant to be used themselves for later finishing, then 
you may want to simply pass the source image data through unaltered. However, if you’re creating 
offline media for editors, directors, and producers to watch for the next three months, you can 
grade this data in a variety of ways to provide more pleasing output.

In the case of Log media, you could apply a LUT to the entire project that’s designed to 
“normalize” the particular log characteristics of the media you’re processing. Project-wide LUTs 
can be applied in the Look Up Tables panel of the Project Settings. For more information, see 
Chapter 2, “Project Settings.”

Project-wide LUT table settings on the Look Up Tables panel of the Project Settings

In the case of LUT-managed shooting workflows where a variety of LUTs have been designed to 
monitor different collections of source media, you can manually apply individual LUTs to one or 
more selected clips using the Media Pool’s contextual menu. You can also apply individual LUTs 
in the Node Editor of the Color page. For more information, see Chapter 12, “Advanced Color 
Features.” Alternately, if you’ve been provided with a CDL-compliant EDL that was used to manage 
the looks from a project being organized, you can use the ColorTrace™ from CDL command to 
batch import grading information from another application, described later in this chapter.
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If a LUT is not appropriate, you can manually grade individual clips as you would with any project. 
However, if you want to create a fast “one-light” adjustment for every clip in the Master Timeline 
at once, you can use the Track grade mode of the Node Editor in the Color page to apply a single 
correction simultaneously to every clip in the Master Timeline. This is particularly useful as you can 
readjust the Track grade as much as you like, and the changes are automatically applied to every 
clip in the Timeline. For more information, see Chapter 6, “Node Tree Structures.” 

Step 4—Export Media Suitable for Editing

Once you’ve organized your clips, synced the dailies, and applied whatever grading is necessary for 
the purpose at hand, you’ll use the Deliver page to set up the format, file naming convention, and 
organization of the media you’re outputting for editing or finishing.

Deliver page with Source order selected for rendering

Furthermore, if you need to apply a window burn, watermark, or logo to the media you’re processing, 
that can be accomplished in the Data Burn-In palette of the Color page. Window burns can be 
formatted with a lot of flexibility, and are written out to media that’s either rendered or output to 
tape. For more information, see Chapter 6, “Data Burn In.”

Selecting Track in the Node Editor
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Selections on the Data Burn-in palette

Once you’ve selected the appropriate Render settings and Window Burn options, you can output 
one or several versions of the media, to accommodate jobs where you need to provide several 
media deliverables. For more information on setting up and using the Deliver page, see Chapter 8, 
“File-Based Output.”

Step 5—Reconform Media to an EDL, AAF, or XML Project File

Once the offline media you’ve delivered has been edited, it’s simple to reimport the edited project 
via an EDL, AAF, or XML file, depending on which is most suitable to your application. This edit data 
can be used to reconform the original media that you imported into the Media Pool, so that you 
immediately have access to whatever graded adjustments you made to create the offline media, as 
applied to the source media. 

Imported project exchange files create new Timelines in the Edit page, and you can import multiple 
subsequent Timelines to accommodate changes that have been made to the edit, if you find 
yourself grading a project that is in progress editorially. In fact, depending on how you set up your 
grades, they can automatically ripple to follow each clip when you import a re-edited version of the 
program as a new timeline, saving you from having to recreate your work. For more information on 
this, see Chapter 13, “The Gallery and Grade Management.”

Step 6—Output Final Media for Finishing

Once you’re finished with your final grade, you’ll again use the controls of the Deliver page to render 
the program’s final media, either as individual clips for a round-trip workflow, or as a single media 
file or image sequence for delivery as a digital master.
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XML and AAF import are the most straightforward methods of bringing edits with as many video 
tracks as you need from different NLEs into DaVinci Resolve. XML and AAF import have the added 
benefit of allowing a variety of supported effects to be imported along with the edit data, as well 
as multiple tracks of video data. This chapter covers the relatively simple procedure used to import 
XML projects into DaVinci Resolve. The same procedure is used for AAF import, although for a 
smooth round trip you’re encouraged to consult Chapter 4, “Before You Conform.”

Preparing An XML Round Trip

There are currently three NLEs that can use XML to round trip projects to DaVinci Resolve and back 
again. In general, exporting XML for use by DaVinci Resolve is straightforward, and there really 
aren’t any settings you need to manage when exporting an XML file other than the version of XML 
you want to export. For this reason, it’s best to do whatever timeline management you need to 
before XML export. For more information on best practices, see Chapter 4.

Final Cut Pro X, Final Cut Pro 7, and Premiere Pro XML Round Trips

DaVinci Resolve can import projects that were exported to the Final Cut Pro 7 or Final Cut Pro X 
XML formats. 

Premiere Pro also uses the Final Cut Pro XML project exchange format to accommodate round-
trip workflows. You need to make sure that you’re exporting XML from Premiere Pro version 
5.5.1 or newer.

Managing Your Media

When importing XML projects (or EDLs, or AAFs for that matter), it’s easier to conform to the 
accompanying media files if they’re all located in a single directory. Having media sorted into 
multiple directories is fine as long as they’re all within a single main directory that you can select at 
the appropriate stage of project import.

Importing XML Project Files

This section covers the AAF/XML import dialog in much more detail. One procedure lets you 
accomplish any of the following workflows:

Importing an XML or AAF file and automatically conforming to and importing the media 
it’s linked to.

Importing an XML or AAF file and manually choosing another set of media, presumably in 
a different format or resolution, with identical metadata, to conform to instead.

Importing an XML or AAF file that’s linked to offline media derived from a camera original 
format, and automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options.

Conforming XML Files
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To load an XML or AAF file and automatically link to its referenced media:

1. Do one of the following:

 > From any page, choose File > Import AAF, EDL, XML.

 >Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

2. Using the file dialog that appears, find the project file you want to import, and Clip Open.

 The Load AAF or Load XML window appears, depending on your selection.

3. Choose the options that are applicable to your particular project. By default, these options are 
based on metadata within the file you selected.

 > Source File: The file you selected in the previous step.

 > Import Timeline: This pop-up menu lets you choose which sequence to import as a 
DaVinci Resolve timeline, if there are multiple sequences within the source file.

 > Timeline name: The name of the Timeline you’re about to create. This defaults to the 
name of the sequence that was exported.

 >Master timeline start timecode: The timecode at which the imported edit will start. 
This automatically matches the start timecode of the selected Timeline.

 > Automatically set project settings: Turn this option on if you want to overwrite the frame 
size and frame rate settings in the Project tab of the Config page with those in this window.

Options when importing an XML
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 > Automatically import source clips into media pool: Leave this checkbox on to automatically 
import the media referenced by the AAF or XML project file you selected into the Media 
Pool for immediate reconnection. If the media files are not automatically located, you will 
be prompted to manually select the directory where the clips are located.

 > Ignore file extensions when matching: Turn this checkbox on if you want to manually 
choose a different directory of media to link to, for example if the XML you’re 
importing links to ProRes Proxy media, and you want to relink to another directory of 
corresponding ProRes 4444 media.

 > Link to source camera files: Turn this checkbox on if you want to reconform the 
imported project file to the camera original files that correspond to the offline media 
that’s currently referenced.

 > Use sizing information: Lets you import position, scale, and rotation data from AAF and 
XML project files.

 > Use color information: This option is only available for Final Cut Pro X XML files, letting you 
import selected color correction data from the Final Cut Pro X color board controls.

 > Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in Resolve. The default is whatever resolution is specified in the project 
file being imported.

 > Timeline framerate: By default, this is derived from the frame rate of the selected project 
file being imported.

 > Use drop frame timecode: By default, this is derived from the frame rate of the selected 
project file being imported.

 > EDL framerate: By default, this is derived from the frame rate of the selected file.

 > Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

 > Handle mixed frame rate material: When this checkbox is enabled, Resolve conforms and 
processes all clips in the Timeline to play at the frame rate selected in the “Calculate Timecode 
At” setting for that project. When mixed frame rate timelines are rendered out as individual 
source clips, all clips are rendered individually at their original frame rate. If rendered as a 
‘single clip’, all clips are converted to the “Calculate Timecode At” frame rate and rendered 
as a single media file. This checkbox also appears in the Master Project Settings.

 >Mixed frame rate format: This pop-up menu lets you choose the method used to conform 
mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or 
“Final Cut Pro X” methods of conform, while for projects imported from Premiere Pro, 
Smoke, or other NLEs, you should choose “Resolve.” This pop-up menu also appears in the 
Load AAF or XML dialogs when you import a project.

4. After choosing all necessary settings, click OK.
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5. Assuming you left “Automatically import source clips into media pool,” turned on, if the media 
linked to by the XML or AAF file is not in the expected disk location, or if you turned on the 
“Ignore file extensions when matching” checkbox, then another window appears prompting 
you to choose the folder within which the media for this project is stored. 

 If necessary, navigate to the folder containing your media (all subfolders will be automatically 
traversed as well), select it, and click OK.

 Important: It’s always possible to choose the top level of any volume to automatically find all 
media in any directories located within, but if the volume is large and full of many files, scanning 
every folder and document of the volume may be an extremely time-intensive process.

Selecting the source folder for your XML imported clips

Selecting the source folder for your XML imported clips
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The AAF/XML file is imported. A new Timeline appears in the Timelines list, the referenced 
media files appear in the Media Pool, and the clips appear in the Timeline Editor. Clips that 
could not be linked to a corresponding file in the Media Pool appear with a red x to indicate 
that they’re unconformed.

If you find there are many unconformed clips in the resulting imported Timeline, and that these clips 
correspond to media that was placed in another directory, there’s an easy way to fix this.

To import unconformed clips and reconform them to the Timeline:

1. On the Edit page, right-click a timeline in the Timelines list that has unconformed clips, and 
choose one of the following commands:

 > Import > Additional Clips With Loose Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Loose 
Filename Match” command ignores file extensions, which lets you replace offline media 
with online media in a different format.

 > Import > Additional Clips With Tight Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Tight 
Filename Match” command searches only for media with identical file extensions.

2. Choose the directory with the remaining media to be conformed in the dialog that appears, 
and click OK.

 If the conditions necessary for matching the media files in the directory you selected to the 
unconformed clips in the current Timeline are met, then the needed files are automatically 
added to the Media Pool, and the unconformed clips become conformed.

If there are other problems in your imported Timeline such as reel conflicts, incorrectly conformed 
media, or clips you need to simply replace, there are numerous procedures available to deal with 
these issues in Chapter 5, “Working in the Edit page.”

Conformed Timeline showing missing clips
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Conforming AAF Files

AAF (Advanced Authoring Format) is a project exchange format, originally developed by the 
Advanced Media Workflow Association (AMWA). Commonly used applications that export project 
data in the AAF format include Avid Media Composer, Avid Symphony, and Adobe Premiere Pro.

This chapter describes some recommended workflows for moving projects from Media Composer 
(or Symphony) to DaVinci Resolve for grading, and then returning to Avid Media Composer  
for finishing.

Supported Media Types in AAF Round Trips

Media Composer provides several methods of ingesting and managing compatible media formats. 
Ultimately, which formats are suitable for a Media Composer to Resolve round trip depends on 
whether they’re compatible with Resolve.

There’s one other thing to keep in mind as you’re managing media in Media Composer; not all 
formats are compatible with all media management operations. This combination of format 
compatibility and operational compatibility requires you to carefully tailor your workflow around 
which media files you’ll be using.

Transcoding to DNxHD Always Works

Since DNxHD was developed as Media Composer’s core codec, workflows where you transcode 
other media formats to MXF-wrapped DNxHD before editing will always work, and are the simplest 
when round tripping between Media Composer and DaVinci Resolve. At the time of this writing, 
Resolve supports both MXF-wrapped and QuickTime-wrapped DNxHD media. 

Linking to Media Using AMA and Consolidating

Avid Media Access (AMA) is a means of directly linking clips to media files in Media Composer 
without needing to either transcode them to DNxHD MXF files, or copy them to an Avid MediaFiles 
directory. While convenient, workflows involving media that’s linked using AMA require a bit more 
forethought.

Not all AMA-compatible media formats can be consolidated, which limits your ability to create 
a smaller, more portable collection of media to move into DaVinci Resolve. Whether or not an 
AMA-linked clip can be consolidated depends on its media format; Media Composer can only 
consolidate formats that it can write. For example, since Media Composer cannot write R3D media, 
then R3D media cannot be consolidated.

Furthermore, not all AMA-compatible media formats are compatible with DaVinci Resolve. Simply 
being able to edit a media format in a Media Composer timeline doesn’t guarantee you can use it 
in Resolve. The following table lists which media formats can be AMA-linked in Media Composer, 
which formats can be consolidated, and which are compatible for use in DaVinci Resolve.
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If you’re prepping a sequence that uses a mix of media formats, some of which can be consolidated, 
and some of which can’t, you should transcode all clips that aren’t compatible with consolidation to 
an Avid native codec before beginning the process of consolidating media and exporting an AAF 
to DaVinci Resolve.

Fast Imported Media

Another wrinkle is that Media Composer supports a media ingest method called “Fast Import,” 
where imported media is quickly copied to the Avid MediaFiles directory by inserting the original 
image data using the original codec into an MXF wrapper. This is an extremely fast and efficient way 
to bring media into Media Composer projects, but the resulting files are not typically compatible 
with DaVinci Resolve.

On the other hand, keep in mind that any media format that can be Fast Imported can also be 
consolidated. If you’re planning to round trip a sequence that uses Fast Imported media, it’s 
recommended that you either transcode the Fast Imported clips to DNxHD prior to AAF export, or 
conform your exported AAF project to the camera original media in Resolve instead.

Tip: Whenever you use a combination of media in your project that includes formats that aren’t 
compatible with DaVinci Resolve, you can use the “Transcode Video To” checkbox in the options 
of the Export As dialog when exporting an AAF project. This option lets you to transcode all media 
that isn’t a compatible format into a format that is compatible. 

Can be Natively 
AMA-Linked

Can Be 
Consolidated

Resolve 
Compatible

ARRI ALEXA Raw Yes Yes Yes

AVCHD No No No

Canon XF (C300) Yes Yes Yes

CinemaDNG No No Yes

GFCAM (Ikegami) Yes Yes No

P2 Yes Yes No

QuickTime (ProRes) Yes Yes Yes

R3D (RED) Yes No Yes

Sony F65 Raw Yes No Yes

Sony HDCAM SR (SStP) No No Yes

Sony XDCAM Yes Yes Yes

Compatible AMA linked formats
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Performing an AAF Avid Round Trip

This section outlines a comprehensive workflow for creating projects in Media Composer that will 
be compatible with DaVinci Resolve, moving projects from Media Composer to DaVinci Resolve, 
then grading, rendering, and sending the final graded project back to Media Composer. The 
following steps include procedures covering the following tasks:

Ingesting all media as high quality MXF-wrapped DNxHD, then round tripping from Media 
Composer to DaVinci Resolve.

Importing and editing Resolve-compatible AMA-linked media formats, then round tripping 
from Media Composer to Resolve.

Transcoding AMA-linked media files into offline-quality DNxHD clips for editing, then 
exporting an AAF file and reconforming it in Resolve to high quality camera-original media 
as part of the round trip.

Because there are so many variations in the way that Media Composer can ingest media and output 
AAF projects, you should familiarize yourself with the following procedures before continuing with 
your own project.

Step 1—Create a Project in Media Composer

1. When creating a project in Media Composer, take note of the image format details, as these 
should be matched in DaVinci Resolve. In particular, set the image format (e.g., 1080p/24) and 
raster dimensions (e.g., 1920x1080) to match your desired mastering format. Also, color space 
should be set to RGB 709 if you’re planning to send ingested/transcoded media from Media 
Composer to Resolve for grading.

 Note: This information can also be found in the Avid Project Format tab.

2. Open your project, and ingest all necessary media into a new Bin using one or both of the 
following methods:

 > Transcode media for editing: The simplest workflow for AAF import and round-trip workflows 
is to ingest transcoded, native MXF-wrapped DNxHD media using the Import command.

 > Import AMA-linked clips: You can also import AMA-linked clips, so long as all AMA-
linked files are in a format that’s compatible with Resolve. Keep in mind that not all AMA-
compatible formats can be consolidated in Media Composer. In this case, import AMA-
linked media into a new Bin using the Link to AMA File(s) command, and edit as usual.

Once you’ve ingested all necessary media, you can edit your project as you would any 
other, keeping in mind which effects are compatible with DaVinci Resolve. For more 
information on effects in Media Composer to Resolve round trips, see Chapter 4, “Before 
You Conform.”
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Step 2—Exporting an AAF for DaVinci Resolve

When you’re finished editing, you need to export an AAF that will conform the .mxf media you used 
in Media Composer into a DaVinci Resolve timeline. Two export configuration options are available, 
depending on whether DaVinci Resolve and Media Composer are on the same system.

1. Select the sequence you want to export, and choose File > Export.

2. In the Export As dialog, type a name for the AAF file you’ll be exporting.

3. Choose a location to save the AAF. You can save it anywhere you like, but if you’re moving the 
project to another workstation, you may want to save it to a specific folder on a removable 
hard drive where you store your AAF and XML files. The location you choose can also be used 
as the location of the media that’s exported to accompany the AAF.

4. Click the Options button to open a more detailed window of export settings.

5. Turn on the AAF Edit Protocol checkbox. This option forces Media Composer to export 
a simplified AAF file that’s more compatible with the project exchange workflows of 
different applications.

6. Choose the appropriate option from the Export Method pop-up menu to configure how 
the AAF and its accompanying media will be exported. The option you choose depends 
on the following:

 > If Media Composer and Resolve Are on the Same System: Choose “Link to (Don’t Export) 
Media” to export an AAF file that links to the existing media in its current location. Click 
the Audio Details tab and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

 > If Media Composer and Resolve Are on Different Systems: Choose one of the two following 
export methods:

 > Choose Copy All Media: For each source clip used, the entire corresponding media 
file is copied. This can be useful when you want to preserve the original relationship 
of each clip to the source media file it came from. However, be aware that you’ll 
potentially be exporting a lot of media when you use this option.

 > Choose Consolidate Media: This is a more efficient media management workflow for 
finished projects, since unused media will not be copied. You can specify additional 
handles to add to the beginning and end of each exported media file, in frames, in the 
Handle Length field. Should any media file and its handles overlap another media file 
and its handles, both will be combined into a single exported media file.
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7. (Optional) If you’re using a combination of media in your project that includes formats that 
aren’t compatible with DaVinci Resolve, you can optionally turn on the “Transcode Video 
To” checkbox and choose a media format from the pop-up menu to the right. This option 
automatically transcodes all media in your sequence that doesn’t match the format specified 
in the pop-up to match that format.

8. If you’re copying or consolidating media to another drive, choose “Folder” from the Media 
Destinations Video/Data pop-up menu. Turn on the “Use Same Folder As AAF File” checkbox 
to save the exported media to the same folder you selected in step 3. If you leave this checkbox 
turned off, you can click Select Folder to choose another location.

9. Click Save, and when you return to the Export As dialog, click Save again.

Once export is complete, you’ll see a duplicate sequence and duplicate media populating your 
Media Composer bin, with the suffix “.Exported” appended to the sequence, and “.new” appended 
to each media clip.

In the file system, the resulting folder contains an AAF file, and an Avid MediaFiles folder that 
contains the exported media.

Step 3—Conforming Your AAF in Resolve

1. Open DaVinci Resolve and create a new project.

2. First, you need to set Resolve to properly read the timecode and reel number information from 
the Media Composer files. Click the gear button at the lower left-hand side of the Resolve 
window to open the Project Settings window, click Master Project Settings, scroll down to the 
Conform Options, and do the following:

 > Set “Use Timecode” to “Embedded in the source clip.”

 > Turn the “Assist using reel name from the” checkbox on, and choose “Embedding in source 
clip file.”

Conform assistance with reel names embedded in the source clip
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3. Click Save.

4. Do one of the following:

 > From any page, choose File > Import AAF, EDL, XML.

 >Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML. 

5. When the File Selection window opens, select the AAF file you exported from Media 
Composer, and click Open.

6. When the Load AAF dialog appears, the settings you choose determine which media files the 
AAF will be conformed to:

Import AAF window conform options

 > To conform to the transcoded or AMA-linked media files you edited: Turn on the 
“Automatically import source clips into media pool” checkbox. 

 > To conform to a different set of camera-original files: Turn on both the “Automatically import 
source clips into media pool” checkbox, and the “Link to source camera files” checkbox, 
which properly accounts for the difference in file naming between transcoded and camera 
original raw media.

 > To conform to a directory of media of your choosing: Turn on both the “Automatically 
import source clips into media pool” checkbox, and the “Ignore file extensions when 
matching” checkbox.

7. Additionally, you want to always make sure that the “Automatically set project settings” 
checkbox is on. Optionally, you can turn on the “Use Sizing Information” checkbox if you want 
to import position, scale, and rotate transform data from the project into Resolve.

8. Click OK.

 As long as the media remains where it was when you exported it from Media Composer, the 
timeline and all its media should now import.
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 However, if the location of the media files you’re conforming to has changed, then you may 
need to identify the location of the media in a second step. For example, if you’ve copied the 
media from the portable hard drive it was originally conformed to, to a faster storage volume, 
then a file dialog appears, requesting that you choose the folder containing the media used 
by your project. If prompted, do so and click OK.

Once import is complete, the Media Pool fills with the source media used by the imported project, 
and the edit appears as the current Timeline.

Step 4—Grade the Project

Grade each clip on the Color page as you would any other. However, you should be aware that if you 
use the tools found in the Edit page to make any editorial changes to the timeline you’ve imported, 
your export options will change later on:

 > If you don’t make editing changes: Then you have the option to have DaVinci Resolve use 
the Avid AAF file that you originally imported to generate an updated one. This preserves 
audio and all other unsupported effects from the original AAF file, so that they reappear 
when you export a new AAF back to Media Composer. If you use this option, you need to 
make sure the original AAF file you import remains in the same location.

 > If you do make editing changes: Then you need to use the “Generate New AAF” command 
to export an AAF of the re-edited timeline from Resolve back to Media Composer. This 
newly generated AAF file will not include audio, nor will it include any effects that are not 
supported by Resolve.

Step 5—Render and Export a New AAF

1. When you’re ready to send a graded project back to Media Composer, Open the Edit page 
and select the Timeline you graded.

2. Open the Deliver page.

3. Choose “Avid AAF Round-Trip” from the Easy Setup pop-up menu in the Render Settings list.

Selecting the AAF easy setup for Round-Trip 



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

406

PREPARING AND CONFORMING PROJECTS9

4. In the Output section, choose the MXF codec you want to render to.

5. Make sure you leave the Output Options checkbox “Render Clip with Unique Filename” 
turned on. This ensures that each clip rendered has a different file name as multiple clips in 
the edited sequence may originate from the same source clip.

6. If you require handles for your rendered output, you can enter a number into the Frame 
Handles field of the Output options.

7. Choose the appropriate file destination path for the rendered media. This folder can be 
anywhere you want, but the location you choose depends on whether Media Composer and 
Resolve are on the same computer or not.

 > If Media Composer and Resolve are on the same computer: Create a new folder within 
your Avid MediaFiles folder (Avid MediaFiles/MXF/) named with a number. Make sure you 
choose a previously unused number.

 > If Resolve is on a different computer using different storage: Select any directory on the 
portable hard drive you’ll be using to bring the media back to the Media Composer 
workstation from which it came.

8. Click Add Job to add the current render setting to the Render Queue, and click Start Render.

9. After rendering is complete, open the Edit page, make sure the Timeline you rendered is still 
selected, and do one of the following, depending on whether you made editorial changes to 
the Timeline in the Edit page:

 > If you didn’t make any editing changes to the timeline you imported, then choose File > 
Save XML/AAF, and choose “AAF” from the Format pop-up menu. This exports all audio 
and effects using data from the original AAF file that was exported from Media Composer, 
regardless of whether or not they’re supported in Resolve. 

 > If you did make editing changes to the timeline you imported, then you need to right-click 
the Timeline you want to export in the Timelines list and choose Export > Generate New 
AAF. This option creates a brand new AAF file that preserves your editorial changes, but 
audio and effects that are not supported in DaVinci Resolve are discarded. 

10. If you like, enter a new title for the sequence. By default, the exported file is named identically 
to the original, but with the suffix (Resolve) appended.

11. Click Save.

Note: When you export an unedited AAF, DaVinci Resolve uses the Avid AAF file that you originally 
imported to create an updated one; make sure it’s still in the same location as it was when you first 
imported it into Resolve.
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Step 6—Copy the Graded Media to Avid MediaFiles

1. For workflows where Resolve and Media Composer are on separate workstations, locate the 
media directory containing the media files that were rendered out of Resolve on the portable 
hard drive being used to transport the project back to your Avid workstation, and copy it to 
the Avid MediaFiles/MXF/ directory.

2. Rename the directory to be a number. Make sure you choose a previously unused number.

Step 7—Import the Graded AAF

1. Reopen the original project in Media Composer. If the media in the new directory of the 
Avid MediaFiles folder is in a compatible format, it will automatically be added to the internal 
database of media.

2. Create a new bin to contain the graded sequence you’re about to import.

3. Open the new bin, then choose File > Import, select the graded AAF file that you exported 
from Resolve, and click Open.

 As long as the media is available in the Avid MediaFiles directory, the new bin you’ve created 
should automatically fill up with the clips that were rendered out of Resolve, and a new 
sequence should appear.

4. Double click the sequence you’ve imported to open it into the Record monitor and Timeline, 
fully conformed with the color corrected clips from DaVinci Resolve. 

 This sequence is now ready for finishing in either Media Composer or Symphony.

Relinking Transcoded Media to AMA Media

This next workflow is useful when you’ve been editing transcoded, offline versions of processor- or 
bandwidth-intensive media, but you want to send the original high-quality source media (such as 
ALEXA or RED raw files) to Resolve for grading. In certain situations, it may be better to reconform 
your sequence to the original AMA-linked media files in Media Composer before you round trip 
from Media Composer to DaVinci Resolve.

Step 1—Relink Your Transcoded Media to AMA-Linked Source

1. Edit a sequence using media that you’ve transcoded within Media Composer.

2. When you’re finished, open the bin that contains your project’s camera original media, and 
select the AMA-linked clips that correspond to the transcoded clips you’ve been editing.

3. Right-click the edited sequence in its bin, and choose Relink from the contextual menu.
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4. When the Relink dialog appears, turn on “Select items in ALL open bins,” and leave the 
“Create new sequence” checkbox turned on.

 A new sequence is created that is now linked to the AMA-linked camera originals.

Step 2—Export an AAF File

1. Select the new sequence that was created, and choose File > Export.

2. Type a new name, choose a location for the file, and click Options.

3. Choose AAF from the Export As pop-up menu, and choose “Link to (Don’t Export) Media” 
from the Export Method pop-up menu.

4. Click Audio Details, and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

5. Click Save to exit the Export Settings dialog, and then click Save again to export the file.

Step 3—Import the AAF, Grade, Render, and Export

1. Open Resolve, and import the AAF file you exported into the Edit page. You’ll need to 
manually select the media in a second dialog.

2. Grade the project as you would any other.

3. When you’re done grading, use the AAF Round Trip option in the Deliver page to render the 
graded media into a new (numbered) directory in the Avid MediaFiles directory.

4. Open the Edit page, select the original AAF timeline you imported, right-click it, and choose 
Export AAF/XML. Pick a location for the file and click Save.

Step 4—Reimport the AAF into Media Composer/Symphony

1. Open Media Composer, and import the AAF you exported from Resolve. 

 Your graded sequence is now ready for finishing.
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DaVinci Resolve supports the CMX 3600 format for EDL import and export. The edit decision list 
(EDL) is the lowest common denominator project exchange format there is, and most professional 
postproduction applications are capable of exporting and importing projects in this format.

The universality of EDLs is due, in part, to their longevity; different EDL formats have been in use 
for decades. It’s also due to their simplicity. At least as used by DaVinci Resolve, EDLs describe a 
very narrow range of editorial information, including clip arrangement, clip name (via embedded 
comments), video transitions (cuts or dissolves), and linear speed settings (percentage of fast 
forward or slow motion) for a sequence of shots on a single video track.

Note: While the EDL format supports a variety of SMPTE-defined video transition codes, all EDL 
transitions are turned into cross dissolves of identical duration in Resolve.

If you’re not familiar with the EDL format, each edit appears as a numbered event that contains 
the reel number, edit type, source timecode (In and Out points), and record timecode (In and Out 
points). Here’s a sample of a simple four event EDL:

TITLE: RESOLVE PROMO CUT 9

FCM: NON-DROP FRAME

001 BM_COUNTDOWN.MOV V C  00:01:20:00 00:01:28:01 00:01:20:00 00:01:28:01

002 BL V C  00:00:00:00 00:00:01:23 00:01:28:01 00:01:30:00

003 BL V D 050 00:00:00:00 00:00:02:02 00:01:30:00 00:01:32:02

004 BL V C  00:04:05:10 00:04:09:10 00:01:32:02 00:01:37:02

Since DaVinci Resolve was originally designed to work by importing and exporting EDLs, there 
are several methods you can use to import projects using EDLs. In all cases, you must first add the 
media referenced by that EDL to the Media Pool before you can import its EDL.

The three primary workflows are:

 > Conforming an EDL to individual media files: Importing an EDL that references a collection 
of discrete media files.

 >Notching a “Flattened” master media file using an EDL: Importing an EDL that references 
a “flattened” master media file. Flattened master media files are created when an entire 
program is exported from an NLE as a single self-contained media file.

 > Importing an EDL Directly to a New Track of an Existing Edit: If you’re importing a multi-
track video project, and the only means of doing so is using EDLs, you can export each 
track of the source project as an individual EDL, and then import each EDL into Resolve 
directly into additional tracks of the same Timeline. This is also useful for workflows where 
effects clips are being managed on a separate track assembled elsewhere, that you can 
then import directly into a graded Timeline to place many new effects clips all at once.

This description covers the different ways that EDLs can be used in DaVinci Resolve.

Conforming EDL Files
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EDL Export of a Project and Its Media

Make sure that every clip in your edited sequence, and every source media file it’s linked to, has 
an appropriate reel number/reel name. When conforming EDLs, Resolve requires reel names and 
accurate timecode to successfully conform the project to media in the Media Pool.

To export an EDL that can be easily conformed by Resolve, each NLE has particular settings that 
you should use. The primary supported format is CMX 3600, although Resolve also supports the 
DEDL format exported by both Smoke and Flame. 

There are other details, however, that vary by application. For example, when exporting an EDL 
from Final Cut Pro 7, you need to make sure you set Reel Conflicts to Generic Edits, and turn on the 
File Names checkbox. All other settings are optional, but for a cleaner, easier to read EDL, you can 
turn off the other options for exporting various kinds of EDL Notes.

Conforming EDLs to Individual Media Files

The advantage of working with discrete media files is that they are the “purest” version of the 
media, without any effects (such as dissolves or superimpositions) “baked” into the visuals that 
might create issues when you’re grading. 

1. Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches 
your project and media. Otherwise, the EDL’s timecode will be misinterpreted.

2. Open the Media page, use the Library browser to locate the media you want to add to the 
project, and add it to the Media Pool by right-clicking the enclosing directory and choosing 
one of the following commands:

 > Add Folder into Media Pool: Adds all compatible media files within that folder to the Media 
Pool. Subfolders are not traversed.

 > Add Folder and SubFolders into Media Pool: Adds all compatible media files from that 
folder, and all subfolders within that folder, to the Media Pool.

 > Add Folder Based on EDLs into Media Pool: Prompts you to choose an EDL. Only media 
referenced by that EDL is imported, and only the selected folder is searched for that media.

 > Add Folder and SubFolders Based on EDLs into Media Pool: Prompts you to choose an 
EDL. Only media referenced by that EDL is imported, and the selected folder and all 
subfolders are searched for that media.

Tip: The “Add...Based on EDLs” commands are useful for efficiently adding just the media you need 
to the Media Pool in instances where there might be many terabytes of unmanaged source media, 
most of which is unused.
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3. Do one of the following:

 > From any page, choose File > Import AAF, EDL, XML.

 >Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

 A window appears prompting you to “Choose a file to import.” 

4. Navigate to the EDL file you want to use, select it, and click Open.

 The Load EDL window appears.

5. Choose the options that are applicable to your particular project. All grayed out options are 
not editable, either because they’re not applicable, or are not defined by the Project Settings 
that are currently applied. The options you can set include:

 > Source File: The file you selected in the previous step.

 > Timeline name: The name of the Timeline you’re about to create. This defaults to the name 
of the EDL file you selected.

 > Automatically set project settings checkbox: Turn this option on if you want to overwrite the 
frame size setting in the Master Project Settings panel of the Project Settings. You cannot 
overwrite the Timeline frame rate when importing an EDL.

 > Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in Resolve. This defaults to your Project settings, but can be overridden 
by turning on the “Automatically set project settings” checkbox.

 > EDL framerate: Choose the frame rate of the sequence that you exported as an EDL. You 
can convert the EDL frame rate from 30 to 24 frames per second if you set the Timeline 
frame rate to 24 fps and if the EDL frame rate is set to 30 fps; this is useful when an offline 
edit is done at 30 fps with media using 3:2 pulldown. Note that 25 fps to 24 fps conversion 
is not supported.

 > Use drop frame timecode checkbox: Only enabled if the EDL frame rate pop-up menu is 
set to 30 fps. Turn this on if your EDL uses drop-frame timecode.

6. When you’re finished choosing options, click OK.

 The EDL is imported, a new Timeline appears highlighted in the Timelines list, and its 
corresponding sequence of clips appears in the Timeline editor. Clips that could not 
be linked to a corresponding file in the Media Pool appear with a red x to indicate that  
they’re unconformed. 
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Preconforming “Flat” Media Files to EDLs

Preparing an edited sequence for grading, along with each individual clip of media, can be time 
consuming for effects-intensive projects, or it may be an unnecessary step for a project with no 
effects whatsoever. 

In these cases, it can be simpler and quicker to export a flattened master media file that can 
be split back apart into its individual clips in DaVinci Resolve. This workflow is similar to a more 
traditional tape-to-tape workflow, except that you’re working from a digital master, rather then a 
tape-based master.

The easiest way to do this is to use the Preconform button in the Edit page to split a single master 
file that you’ve imported into the Media Pool back into individual clips in a new timeline.

To preconform a flattened master media file to an EDL:

1. Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches the 
media and EDL you’re preconforming.

 Make sure you’ve picked the correct frame rate, since this option can’t be changed once 
you’ve added media to the Media Pool.

2. If necessary, turn on the “Assist using reel numbers from the” checkbox in the Master Project 
Settings panel of the Project Settings, and click to choose the appropriate option underneath. 
For example, if you’re relinking to R3D media, the default setting of the “Source clip file 
pathname” will base the reel names of each clip on the source media’s file name.

 If you discover later that you’ve chosen the wrong option, you can change this setting, as 
reel numbers for clips in the Media Pool are dynamically regenerated whenever you change 
this setting.

3. Open the Media page, use the Library browser to navigate to the flattened master media file 
that contains the entire program, and double-click that file to add it to the Media Pool.

4. Do one of the following:

 > From any page, choose File > Import AAF, EDL, XML.

 >Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

5. In the “Select an EDL file” dialog that appears, navigate to the EDL that matches the flattened 
master media file, select it, and click Open.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

413

PREPARING AND CONFORMING PROJECTS9

6. In the “Parse preconform options” dialog that appears, give the new timeline a name, 
and click OK.

 A new timeline appears in the Timelines list, and the Timeline editor shows its clips, ready for 
grading. Clips that could not be linked to a corresponding file in the Media Pool appear with 
a red x to indicate that they’re unconformed.

Conforming “Flat” Media Files Using Split and Add

The second method of conforming an EDL to a flattened file is to use the “Split and Add” command 
in the Media page to split one or more master media files into individual clips that match those of 
an EDL, then importing the EDL itself in the Conform page in a second step. 

This method is useful if there are clips in different folders or volumes that you want to conform to 
a single EDL. For example, the majority of the first reel of a program may have been exported as a 
single flattened file, but the corresponding EDL may require that an additional folder of effects clips 
be added to the Media Pool to be fully conformed.

To split a flat media file in the Media page, and import its EDL in the Edit page:

1. Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches 
your project.

2. Open the Media page, use the Library browser to navigate to the flattened master media file 
that contains the entire program.

3. Select the flattened media file, right-click it, and choose “Split and Add into Media Pool.”

4. In the “Select EDL files for splitting clips” dialog that appears, navigate to the EDL that matches 
the flattened master media file, select it, and click Open.

5. Select the frame rate of the project from the File Conform Frame Rate dialog that appears. This 
frame rate should be identical to the “Timecode calculated at:” pop-up you set in step 1. 

6. Choose the appropriate options in the “Enter handle size for splitting” dialog that appears:

 > Handle size in number of frames: Enter a number of frames to be added as handles to 
the first and last frame of the clip. This is useful when you’re using the “Split and Add into 
Media Pool” command to import only the referenced sections of a directory of individual 
media files.

 > Split Unreferred Clips: Useful when the referenced media files include segments that aren’t 
“referred to” by any events within the EDL used to split them. Turning this checkbox on 
adds all such unreferred clip segments to the Media Pool as separate clips, for possible 
later use.
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7. Click Split & Add.

 The Media Pool fills up with individual segments of the flattened master media file, each of 
which matches an event in the EDL you used to split it.

8. Do one of the following:

 > From any page, choose File > Import AAF, EDL, XML.

 >Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

9. In the “Choose a file to import” dialog that appears, navigate to the EDL that matches the 
flattened master media file, select it, and click Open.

10. Choose whatever options are necessary from the Load EDL dialog that appears (the default 
settings should work fine), and click OK.

 The Master Timeline and the timeline you just imported appear in the Timelines list, the 
Conform EDL list updates with the events from the imported EDL, and the Timeline editor 
shows the edited clips, ready for grading. Clips that could not be linked to a corresponding 
file in the Media Pool appear with a red x to indicate that they’re unconformed.

Importing an EDL to a New Track

This last procedure describes how to add an EDL, not as an individual new Timeline, but as an 
additional video track to an existing Timeline. There are many reasons you might want to do this. 
For example, if you need to move a multi-track project to DaVinci Resolve from an application 
that can’t export either AAF or XML project exchange files that Resolve understands, you can use 
multiple EDLs. Simply export each track of the source project as an individual EDL, and then import 
each EDL into Resolve as additional tracks of the same Timeline.

This is also useful for workflows where effects clips are being managed on a separate track 
assembled elsewhere, that you can then import directly into a graded Timeline to place many new 
effects clips all at once.

To import an EDL to a new track of an existing timeline:

1. In this procedure, you have the option of adding whatever media is required by the EDL you’re 
about to import to the Media Pool first, or you can add the media after the EDL has been 
imported. It’s your choice.

2. Open the Edit page, select a timeline in the Timelines list, then right-click it and choose Import 
> EDL to New Track.

 A window appears prompting you to “Choose a file to import.” 
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3. Navigate to the EDL file you want to use, select it, and click Open.

 A new video track is created above any previously existing tracks, and events from the 
selected EDL are immediately loaded into it according to their record timecode positions.  
If you loaded the media needed by the new clips at the beginning of this procedure, that 
media should be conformed. Otherwise, you’ll need to track down the media files needed by 
the new unconformed clips and add it to the Media Pool now.
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When you set the Left Viewer in the Edit page to Offline mode, you’re able to compare an Offline 
Reference Clip to a timeline with both playheads ganged together. As you play the timeline, the 
Offline Reference Clip file plays as well. 

An Offline Reference Clip must be added to the Media Pool specifically as an “offline” clip, and is 
associated with a particular timeline by right-clicking that timeline in the Timelines list and choosing 
it from the Link Offline Video submenu.

The idea is that if your client exports a flattened version of their edited sequence at the same time 
as they export the EDL, AAF, or XML project file they want graded, then you can compare the 
project data that’s imported into Resolve to the actual video of the offline edit. 

Note: Typically, the flattened version of the program you’re given uses a low-quality codec, and 
contains effects and color correction that’s not final, which is why it’s called an Offline Reference Clip.

There are two reasons for comparing an Offline Reference Clip to a timeline:

 > Verifying the clip order: If you’re unsure whether or not you’ve properly resolved reel 
conflicts or other problems that occurred while you were conforming a timeline, you can 
compare each edit to the offline version of the program to spot problems and identify the 
proper media that should correspond to any clip.

 > Recreating effects: If there are offline effects, such as temporary grades made in the NLE, 
or pan and scan transforms that you want to check, the Offline reference mode lets you 
split-screen your current grade against the Offline Reference Clip in the Color page.

Setting Up an Offline/Timeline Comparison

Here’s how to compare Offline Reference Clips to a timeline.

Important: You need to make sure that the media you’ve imported as an Offline Reference Clip has 
a valid timecode track, otherwise this procedure won’t work.

To compare a timeline with an Offline Reference Clip:

1. Open the Media page, and use the Library browser to find the flattened Offline Reference Clip 
that you want to use for comparison.

2. Right-click the Offline Reference Clip file and choose Add as Offline Clip.

 That clip appears with a small checkerboard badge in its icon in the Media Pool.

Checking a Conform Using an Offline Reference Clip
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Checkerboard indicating an Offline video

3. Open the Edit page, right-click the timeline you want to review against the Offline Reference 
Clip, and choose the offline clip you imported from the Link Offline Reference Clip submenu.

Selecting the Offline video to link to the current Timeline

4. Click the checkered Offline button at the left of the Source Viewer’s transport controls.

Selecting the Offline video in the Source Viewer

 The Offline Reference Clip now appears within the Offline Viewer, and plays back in sync with 
the Timeline. If your clips are graded, you can see the comparison between the state of each 
clip in the Offline Reference Clip, and the graded timeline clip.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

418

PREPARING AND CONFORMING PROJECTS9

The Viewers in Offline/Timeline mode
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DaVinci Resolve provides tools to help you deal with problems that can occur when importing 
project files in any format from a variety of sources.

Relinking Unconformed Clips by Importing Additional Media

There are two more Import commands that are useful when there are unconformed clips in a 
timeline because the media files were missing from the directory that was initially selected when the 
XML or AAF project was imported. If you find that these unconformed clips correspond to media 
that was placed in another directory, there’s an easy way to fix this.

To import unconformed clips and reconform them to the Timeline:

1. In the Edit page, right-click the problem timeline in the Timelines list, and choose one of the 
following commands:

 > Import > Additional Clips With Loose Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Loose 
Filename Match” command ignores file extensions, which lets you replace offline media 
with online media in a different format.

 > Import > Additional Clips With Tight Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Tight 
Filename Match” command searches only for media with identical file extensions.

2. Choose the directory with the remaining media to be conformed in the dialog that appears, 
and click OK.

 If the conditions necessary for matching the media files in the directory you selected to the 
unconformed clips in the current Timeline are met, then the needed files are automatically 
added to the Media Pool, and the unconformed clips become conformed.

Dealing With Reel Conflicts

When importing projects from other applications, clips with overlapping timecode and reel names 
will cause reel conflicts. This often occurs when media has been added with timecode but no reel 
identifier (for example, shots from multiple unidentified reels that all start at 0 hour). This may also 
occur if shots are added to the Media Pool incorrectly, such as when replacement shots are added 
to the Media Pool but the original media is still there.

Tip: Overlapping timecode often occurs in the normal course of work, but should be managed by 
altering each clip’s embedded reel name, or by organizing media in different folders.

Reel conflicts within a Timeline can be identified in the Timeline editor by an “attention” icon in 
the thumbnail.

Fixing Common Conform Problems
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Fortunately, DaVinci Resolve has an easy way of resolving reel conflicts.

To resolve a reel conflict by relinking a clip’s media:

1. Right-click the “attention” icon of any clip in the Timeline.

 The Conflict window appears, showing a list of all files in the Media Pool with timecode that 
overlaps the clip you right-clicked. Each item in the list has a thumbnail of the clip, the path 
of the file, file name, starting timecode, reel name, and creation date, to help you determine 
which of the clips in that list is the correct one.

2. Click the radio button of the correct media file for that clip, and click Apply.

 The clip in the Timeline changes to reflect the media you selected, and the “attention” icon is 
replaced with a “resolved” icon indicating the conflict has been resolved.

Conflict Resolution window showing what other clips have overlapping timecode and reel information

Conflict icon indicating at least two clips have matching conform parameters
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Dealing With Linked and Unlinked Grades in Multiple Timelines

If you’ve set your project up to use Remote versions, then any clips that refer to the same file in the 
Media Pool are linked and share the same Remote versions of grades that are applied to them. For 
example, two clips that are close-ups from the same take refer to the same media file, so they’re 
both automatically linked to one another and share the same remote grades. 

Clips using Remote versions also exhibit this behavior when they appear in multiple timelines. Clips 
using Remote versions that are located in different timelines, but that refer to the same file in the 
Media Pool, are linked and share the same remote versions of grades. This is why you can grade 
one timeline, and then import a re-edited version via EDL, AAF, or XML, and have the new timeline 
automatically inherit all grades from the previous timeline.

However, you can override this behavior to have one timeline that’s independently graded from 
the others. Simply select that timeline, open the Color page, right-click any clip in the Thumbnail 
timeline, and choose Copy Remote Grades to Local from the contextual menu. All grades are 
copied to Local versions, and from that point on all changes you make to grades in that timeline 
have no effect on the other timelines in your project. 

For more information about Local and Remote versions, see Chapter 9, “Gallery.”

Re-editing Media Directly in the Timeline

Often you have to replace one clip in a timeline with a different clip. For example, you may need to 
replace an old version of an effects shot with a newer one that’s just been delivered, or an offline 
version of a stock footage shot with a higher quality one. This is easily done using the various editing 
tools described in Chapter 4, “Edit.” For example, you could use a replace edit to match a new 
incoming clip’s timing to the old one. Or you could use a three-point edit, a place-on-top edit, or even 
a simple drag and drop edit to put the new clip into the timeline to take the place of the old one.

A clip badge showing that the conflict was resolved
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Reconform From Bins

The “Reconform From Bins” command is useful for helping you to manually choose which media, in 
projects with multiple Media Pool bins that contain duplicate versions of clips, you want the current 
timeline to be conformed to.

By default, all clips that you add to the Media Pool are stored in the Master folder, which can be 
seen at the top of the Media Pool.

However, you can create bins, located within the Master bin, for adding media that you want to 
organize separately. For example, you could use bins to:

 > Add new versions of VFX clips that you need to place.

 > Add online-quality media with which to replace the offline-quality media you’ve been 
working with so far.

 > Add rescanned stock footage to replace temp clips you were originally given.

In all of these cases, a good way to organize new clips is to create a new Media Pool bin by right-
clicking the Master bin, choosing Add New Bin, and then selecting the new folder when you add 
new clips to the Media Pool.

Once you’ve organized bins of clips in this way, you can use “Reconform From Bins” to select which 
bins you want to conform to the current Timeline. Keep in mind that for this to work, the replacement 
media that you’re adding to these bins must have identical timecode and reel names to the media 
that it’s meant to replace. If the timecode doesn’t match, you’ll need to manually replace the clip in 
the Timeline.

To reconform a timeline to clips within a specific Media Pool bin:

1. Double-click the Timeline you want to reconform to open it..

2. Press Command-A to select every clip in the Timeline, right-click one of the selected clips, and 
choose “Force Conform Enabled” to disable force conform for each clip.

3. Right-click the current Timeline in the Timelines list, and choose Reconform From Bins.

 A folders list dialog appears, with the Master folder displayed.

4. Click the disclosure triangle to the left of the Master bin to reveal the bins contained within.

5. Turn on the checkboxes for the bins with media you want to conform the Timeline to, and turn 
off the checkboxes for bins with media that you want to ignore. 
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6. Click OK.

 The Timeline is automatically updated to conform to the media contained within the bins 
you checked.

If you use “Reconform From Bins” and two clips with identical timecode and reel names are in 
selected folders, you’ll have a reel conflict in the Timeline. By default, the clip that was most recently 
added to the Media Pool is used by default, but you may want to manually resolve such reel conflicts 
just to be sure that you’re using the correct version.

Force Conform

If you have a problem with a Timeline such that an unconformed clip simply won’t automatically 
conform to any clip in the Media Pool, even if you know the clip is there, you can use the Force 
Conform command to force a clip in the Timeline to conform to a clip of your choosing. 

To force conform an unconformed clip to another clip in the Media Pool:

1. Select a clip in the Media Pool.

2. Right-click an unconformed clip in the Timeline, and choose “Force Conform With Selected 
Media Pool Clip” from the contextual menu.

Selecting folders for reconform
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 The selected clip in the Timeline is conformed to the clip you selected in the Media Pool in 
one of two ways:

 If the selected clip in the Media Pool has matching timecode and reel name metadata, then the 
new clip is perfectly conformed as originally specified by the original EDL/AAF/XML project data.

 If the Media Pool clip does not have timecode that matches the selected clip in the Timeline, 
then the new clip is conformed such that the first frame of the Media Pool clip is aligned with 
the first frame of the reconformed clip in the Timeline, and occupies the same duration.

 If you right-click that clip again, you’ll see that the box next to the Force Conform menu item 
is checked, showing you that the clip has been force conformed to media for which it wasn’t 
originally a match.

 Important: The clip you select in the Media Pool must be equal in length or longer than the 
clip you select in the Timeline for Force Reconform to work.
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Creating a stereo 3D project is a multi-step process that benefits from careful media organization. 
This chapter covers how to set up for working on stereoscopic projects, how to import stereoscopic 
projects, and how to export stereoscopic media. Incidentally, if you’re used to how Resolve used to 
handle stereo timelines and media in past versions, be aware that DaVinci Resolve versions 10.1 and 
later simplify the way stereo is handled, making the overall process easier to manage.

First, stereoscopic pairs of clips, i.e., the individual left- and right-eye media files, are imported 
into the Media Pool, organized, and then linked together using the “Stereo 3D Sync” command 
to create a new set of linked stereo clips. Then, these clips stereo clips can be either edited or 
conformed to imported project data using a single Timeline. DaVinci Resolve lets you manage left- 
and right-eye grades and sizing in the Color page using the controls found in the shortcut menu of 
the Thumbnail timeline, and in the Stereo 3D palette. 

If you’re using stereoscopic CineForm media, which contains muxed left-eye and right-eye image 
data that can be decoded by DaVinci Resolve, you still need to go through this process, although 
you’ll be using duplicate clips to populate Left and Right folders with matching sets of clips.

Hardware Requirements for Working in Stereo 3D

With DaVinci Resolve on Mac systems, dual 4:2:2 Y’CbCr stereoscopic video streams are output via 
HD-SDI on the DeckLink HD Extreme 3D+, DeckLink 4K Extreme, or UltraStudio 4K. You can select 
either Side-by-Side or Line Mesh output to be fed to your stereo 3D-capable display, depending 
on its compatibly. Alternately, if you turn on the “Enable Dual SDI 3D Monitoring” checkbox on the 
Settings tab of the Config page, the DeckLink HD Extreme 3D+ outputs full resolution 4:2:2 Y’CbCr 
for each eye to compatible displays.

When setting up a 3D-capable Resolve workstation, keep in mind that the dual video streams of 
3D projects make greater demands on disk bandwidth, media decoding via CPU or RED ROCKET, 
and effects processing via GPU. On Linux systems, stereoscopic performance is similar to that of a 
qualified Mac Pro with the same number of GPUs. Similarly to the Mac Pro, stereo 3D is output via 
HD-SDI on a Blackmagic DeckLink 4K Extreme using either Side-by-Side or Line Mesh output.

Setting Up to Display Stereo 3D

All DaVinci Resolve systems can output a side-by-side frame-compatible signal that can be viewed 
on a stereo 3D-capable display via a single HD-SDI connection, output from a DeckLink HD Extreme 
card. Other Blackmagic Design video interfaces with HDMI 1.4 outputs can also output stereo 3D 
signals; see the documentation accompanying your video interface for more information.

For higher-quality monitoring, two HD-SDI signals can be used to output the left-eye and right-eye 
images separately at full resolution using the DeckLink HD Extreme 3D+, DeckLink 4K Extreme, or 
UltraStudio 4K. Legacy systems accomplish this via NVIDIA dual SDI monitoring outputs. 

Stereoscopic Workflows
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Note: If your stereo display is not capable of multiplexing the two incoming HD-SDI signals by itself, 
you can accomplish this using an external device to multiplex both HD-SDI signals into a single 
stereo 3G signal that will be compatible. Check with your display manufacturer in advance to see if 
this is necessary.

The following procedures describe how to set up stereo 3D monitoring in two different ways.

Monitoring via dual HD-SDI to dual HD-SDI:

1. Open the Master Project Settings panel of the Project Settings, then do the following:

 >Make sure Video Connection is set to YUV 4:2:2 SDI.

 > Turn on the “Use left and right eye SDI output” checkbox.

2. Open the Stereo 3D palette, and do the following:

 > Set Vision to Stereo.

 > Set the Out pop-up menu to None.

If your stereo-capable display only has HDMI input, you can convert the two HD-SDI signals being 
output into a single stereo HDMI signal using a device such as the Blackmagic Design HDLink.

Converting dual HD-SDI to HDMI for monitoring:

1. If you’re using an HDLink to convert the dual HD-SDI channels being output by your 
DeckLink HD Extreme 3D card, then open the Blackmagic HDLink Utility application and do 
the following:

 > Click the 3D tab.

 > Set 3D stereoscopic to Enabled.

 > Set the “3D stereoscopic output format” pop-up menu to the setting that’s compatible 
with your stereo 3D-capable display.

2. Close the Blackmagic HDLink Utility.

3. Turn on the “Enable dual SDI 3D monitoring” checkbox in the Master Project Settings panel 
of the Project Settings.

4. Open the Stereo 3D palette, and set Vision to Stereo.

5. Set the Out pop-up menu to none.

Note: When “Enable dual SDI 3D monitoring” is turned on, split-screen wipes and cursors will not 
be visible on the grading monitor, nor will you be able to view image resizing.
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Supported Stereo 3D Media

When importing stereo 3D media from other applications, there are two types of media that are 
compatible with DaVinci Resolve stereoscopic workflows.

Using Dual Sets of Media in Any Supported Format

When originally shot, the media corresponding to stereo 3D workflows consists of two directories, 
one for the left-eye media, and one for the right-eye media. For the most automated workflow 
possible, this media must be tightly organized. Each pair of left-eye and right-eye media files in both 
directories should have matching timecode, and reel numbers that clearly indicate which are the 
left-eye shots, and which are the right-eye shots.

Using CineForm Media

CineForm stereo QuickTime files are compatible with DaVinci Resolve. CineForm clips encode the 
media corresponding to both eyes and mux (multiplex) it together in such a way so that CineForm 
files may output either a single frame of image data, if used in an application that is not capable of 
stereoscopic processing, or stereo 3D media when used with an application that is, such as Resolve. 
This means that you can edit CineForm media using nearly any NLE, export a project via whatever 
workflow is convenient, and end up with a stereoscopic project that can be graded in Resolve.

There are two ways of creating CineForm files. One is by using a camera or recording system that 
processes dual synchronized video signals to create a single set of CineForm media. The other is to 
use the CineForm conversion tools that come with GoPro CineForm Studio to reprocess dual sets 
of stereo 3D assets into the CineForm format.

The CineForm codec itself encodes full-frame image data using wavelet compression, at any 
resolution, at up to 12-bits, in a choice of RGB, Y’CbCr, or RAW color spaces. DaVinci Resolve is 
compatible with CineForm in a QuickTime wrapper using any supported color space, allowing 
access to the dual streams of image data that are provided.

When the time comes to output your program, keep in mind that while Resolve can read CineForm 
files, CineForm files cannot be rendered out of Resolve unless you’ve purchased an encoding 
license for OS X or Windows from GoPro. Furthermore, Resolve cannot render Stereoscopic 
CineForm files.

Creating Stereo 3D Clips

The very first thing you need to do when working on any stereo 3D project is to create the stereo 
3D clips that you’ll be using. This is a two-step procedure.

Step 1—Import and Organize Your Media

You need to import all of the left-eye and right-eye media into separate bins.
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1. Open the Media page, and create three Media Pool bins named “Left,” “Right,” and “Stereo 
Clips.” The exact names are not important, but the way the media is organized is. 

2. Import all left-eye media into the ”Left” bin, and all right-eye media into the ”Right” bin. If 
you’re importing stereoscopic Cineform media, you still need to create this kind of organization, 
which requires you to place duplicates of each clip into each of the “Left” and “Right” bins.

Step 2—Generate 3D Stereo Clips

Once you’ve organized your media appropriately, you’re set up to synchronize the left- and right-
eye clips using timecode.

1. Create a new bin in the Media Pool, and name it “Stereo Clips.” This is the bin that will eventually 
contain the linked stereo clips you’re about to create.

How to organize media for working in stereo 3D

2. Right-click anywhere within the Media Pool and choose Stereo 3D Sync.

 The Stereo 3D Sync dialog appears, with buttons for choosing the left-eye folder, choosing the 
right-eye folder, choosing the output folder, and checkboxes for specifying whether to match 
reel names and file names, and additional fields for entering characters that identify left- and 
right-eye clips.
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3. Click the Browse button corresponding to “Choose left eye folder” and then use the 
hierarchical list of bins that appears to choose the bin you named “Left.” Follow the same 
procedure to choose the right-eye media. 

4. Click the Browse button corresponding to “Output folder” and then use the hierarchical list of 
bins that appears to choose the bin you named “Stereo Clips.”

5. Choose which matching criteria to use. Ideally, you only need to use whichever one of the 
three criteria that apply. The three options are:

 >  Match Reel Name: If the reel names of the left- and right-eye media match, turn this 
checkbox on.

 >Match File Name checkbox: If the file names of the left- and right-eye media match, 
turn this checkbox on.

 > Left Identifiers and Right Identifiers fields: If the left- and right-eye clips are identified 
by a special subset of characters within the file name (for example, “3D_R” and “3D_L”) 
then you can type each into the appropriate field, and these characters will be used to 
match the left and right eyes together.

6. Click OK.

 The original clips in the Left and Right bins disappear, and a full set of Stereo 3D clips appear 
in the output bin you selected in step four.

The Stereo Media Sync window
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Attaching Mattes to Stereo 3D Clips

If you have left- and right-eye mattes that need to be attached to stereo clips, the process works 
identically to importing mattes for regular clips, except that when you’ve selected a stereo 3D clip 
in the Media Pool, you have two matte import commands, “Add As Left Eye Matte,” and “Add As 
Right Eye Matte.”

Organizing and Grading Stereo 3D Dailies

A common workflow is the creation of digital dailies within DaVinci Resolve before editing in an NLE. 
This provides the editors, director, and producers with the advantage of having more attractive 
media to work with, that’s also more comfortable to view if handled with the automatic geometry 
and color-matching functions that match the media of each pair of shots together for a preliminary 
left- and right-eye balance. The resulting Timelines can then be output to whichever media format 
is most convenient to use.

Step 1—Create 3D Stereo Clips

The very first step in the process of creating dailies is to import all of the left-eye and right-eye 
media into individually organized bins, and to then link them together to create stereo 3D clips, as 
described in the previous section. 

Step 2—Edit the New Stereo Clips Into One or More Timelines for Grading

Now that you’ve created a set of Stereo 3D clips, you’re ready to edit them into one or more timelines 
for grading. You can do this by simply creating a new timeline and deselect the ‘Empty Timeline” 
checkbox. A new timeline will be created with the stereo 3D clips you created. 

Final stereo clips, ready to be edited and graded
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Step 3—Align Your Media

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes 
are aligned. This can be tricky to adjust using manual controls, but is something that can be 
automatically analyzed. You can perform stereo 3D alignment to a single clip using the Stereo 3D 
Palette controls, or you can select a range of clips to align all of them automatically at once. There 
are two methods of alignment; which is more appropriate depends on the type of geometry issues 
you have to address.

 > Transform Alignment: Analyzes the image and makes vertical and rotational adjustments to 
line up the left- and right-eye images as closely as possible.

 > Vertical Skew: Analyzes the images and makes a vertical-only adjustment to line up the 
left- and right-eye images.

Step 4—Grade Your Media

Grade the clips in the Timeline as you would any other digital dailies, with the sole addition of using 
the controls in the Stereo 3D palette to control monitoring and manage the adjustments made 
to each eye as necessary. As when creating any other kind of dailies, you can use LUTs, the Track 
Grade, and individual clip grading to make whatever adjustments are necessary to create useful 
media for editing. 

To help you manage the visual differences between left- and right-eye clips, there are also two 
automatic color matching commands that can be used to batch process as many clips as you need 
to adjust at once.

 > Stereo Color Match (Primary Controls): Uses the Lift/Gamma/Gain controls to match one 
eye to the other. The result is a simple adjustment that’s easy to customize, but may not 
work as well as Custom Curves in some instances.

 > Stereo Color Match (Custom Curves): Uses the Custom Curves to create a multipoint 
adjustment to match one eye to the other. Can be more effective with challenging shots.

 > Stereo Color Match (Dense Color Match): Performs a pixel by pixel, frame by frame color 
match that is incredibly accurate. This operation is processor intensive, so if you’re going to 
batch process many clips, or if you’re matching long clips, you’ll want to make sure you have 
adequate time. Because this is so precise match, it’s recommended to use Dense Color 
Match after you’ve used one of the stereo alignment commands.

Final stereo clips, ready to be edited and graded
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For more information on working in the Stereo 3D palette, and on using the various auto processing 
options for stereo 3D clips, see Chapter 12, “Advanced Color Features.” For more tips on digital 
dailies grading, see“Preparing to Conform,” earlier in this chapter. 

Step 5—Output Offline or Online Media for Editing

When you’re done applying whatever grading is necessary to make the media suitable for 
editing, you’ll need to export each clip as separate left- and right-eye clips using the controls of 
the Deliver page. 

1. Open the Deliver page, and set up your render to output the format of media you require. Be 
sure to do the following:

 > Set Render Timeline As to Individual source clips.

 > Turn on the Use Source Filename checkbox.

 > To render both eyes’ worth of media, choose “Both eyes as” from the Render Stereoscopic 
3D option, and choose Separate Files from the accompanying pop-up menu. 

2. Click “Add Job to Render Queue.”

3. Click Start Render.

 DaVinci Resolve will now render two sets of left- and right-eye clips. 

To make sure that the resulting edited project conforms easily to the originating DaVinci Resolve 
project, it’s important to be sure that you render individual source clips, and that you turn on the 
Use Source Filename checkbox, in order to clone the timecode, reel numbers, and file names of the 
source media.

Conforming Projects to Stereo 3D Media

Since Resolve manages stereo via a single set of specially created stereo 3D clips, you can use the 
same project import methods to import stereo 3D projects as you would for any other project. Only 
a single imported timeline is necessary.

This also means that you can edit stereo projects in NLEs that aren’t otherwise stereo-aware, and 
finish them in full stereo 3D in DaVinci Resolve. To do this, you need to make sure that you edit the left-
eye media in your NLE, and then export either an EDL or XML file to conform in DaVinci Resolve.

Final stereo clips, ready to be edited and graded
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To conform an EDL to stereo 3D media:

1. Open the Media page, and create the necessary set of stereo 3D clips that will correspond to 
the project you’re going to import, as described previously. 

2. Open the Edit page, and then use the Import AAF/EDL/XML command to import your edit.

3. When the Load EDL/XML dialog appears, do the following:

 > If importing an EDL, verify that the frame rate is correct, and click OK.

 > If importing XML, make sure you turn off the “Automatically import source clips into Media 
Pool” checkbox, since you want to relink the imported project to the stereo 3D clips you 
created in step one.

 The left-eye media timecode and reel information that’s embedded within each stereo 3D 
clip will be used to conform the stereo 3D clips with the imported EDL, and you should be 
ready to work.

Grading Mastered Stereoscopic Media From Tape

If you’ve been handed a stereo 3D muxed tape with a mastered program that needs to be graded, but 
you haven’t been given a project file or EDL, you can ingest it as individual left- and right-eye media files 
with a supported VTR, such as HDCAM SR with 4:2:2 x 2 mode, by turning on the “Enable stereo video” 
checkbox in the Deck Capture and Playback panel of the Project Settings. When muxed stereoscopic 
signals are ingested, each eye is separated into individual left-eye and right-eye image files.

Once ingested, you can use Scene Detection to split the left-eye media in one bin, and to create an 
EDL, you can use to split the right-eye media in the same way in another bin, so that you can create 
a sequential set of stereo clips for grading.

Grading in Stereo 3D

Once you’ve either created or imported stereoscopic 3D-identified timeline, you’re ready to begin 
grading. The left eye will be displayed in the Edit and Color pages by default however you can right-
click on the timeline and select to view the other eye. Most colorists work by grading one eye first 
(typically the left), and rippling their grades to the other eye, making separate adjustments to each 
eye’s clips when necessary to match undesirable variation between cameras.

Setting up stereo 3D media enables the Stereo 3D palette on the Color page. This palette contains 
all the controls necessary for working on stereoscopic projects. It provides controls for choosing 
which eye to grade, adjusting convergence, swapping and copying grades and media between 
matching left- and right-eye clips auto-processing the color and geometry of left- and right-eye 
clips to match, stereo 3D monitoring setup, and controls for floating windows.

For more information on making adjustments to stereo 3D clips, see the “Stereo 3D Palette” section 
of Chapter 8, “Color.”
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Outputting Stereo 3D Media in the Deliver Page

To render full frame media, you’ll need to render each stereo 3D timeline separately using the 
controls of the Deliver page, outputting whatever media format is required by the client.

Rendering Frame-Compatible Media

Frame-compatible media has both the left- and right-eye images squeezed anamorphically into a 
single media file. You can turn on the “Enable 3D Stereoscopic Render” checkbox at the bottom of 
the Output options of the Deliver page, and then choose a method of output from the Mesh 
Options pop-up menu. 

Stereoscopic 3D mesh render options on the Deliver page

You can choose Side-by-Side or Line-by-Line. You can also choose Anaglyph if you want to output 
a traditional anaglyph red/cyan stereo 3D image for viewing on any display.

Rendering Individual Left and Right-Eye Clips

If your workflow requires you to deliver separate sets of left- and right-eye media, this is easily 
accomplished by either setting up a render job with “Render Stereoscopic 3D” set to either “Right 
eye” or “Left eye,” or selecting “Both eyes as” and choosing the “Separate files” option.

The Stereo Palette of the Color page
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ColorTrace is a key feature of DaVinci Resolve, which lets you copy grades quickly and easily from 
the clips of one timeline to those within another, based on the source timecode of each clip (or 
using clip names when in Automatic mode). You can even use ColorTrace to copy grades between 
timelines within the same project, and ColorTrace one stereo timeline to another.

Users familiar with previous versions of Resolve will be happy to know that as of Resolve version 
11, ColorTrace copies whichever version of a clip’s grade was applied in the Source timeline you’re 
copying from, either local or remote, depending on which grades each clip in the Source timeline 
is set to use. Furthermore, in Resolve version 11.1, ColorTrace gained support for copying Group 
Pre-Clip and Group Post-Clip grades. These improvements make this an extremely reliable tool for 
copying grades from one timeline to another in a wide variety of situations.

To use ColorTrace:

1. Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline 
Management list.

2. Right-click anywhere within the Timeline, and choose ColorTrace from Timeline.

 The ColorTrace Setup window appears, which shows every database, user, project, and 
timeline within a single hierarchical list.

3. Using the Project List, select the specific Timeline you want to copy grades from.

 You’ll need to click the disclosure triangle to the left of the database, user name, and project 
that contains that Timeline in order to select it.

Copying Grades Using ColorTrace

ColorTrace project and Timeline selection window
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4. (Optional) If you’re using ColorTrace with a project that has numerous VFX clips in a workflow 
where all VFX clips have specific reel names that identify them, you can enter these names 
(with asterisks (*) used as wildcards that indicate text in each Reel Name that can vary) in 
the “Effects Shot Definitions” field. This speeds automatic ColorTrace operations by enabling 
Resolve to use fuzzy string matching when a clip’s reel number qualifies it as a VFX shot so 
that the best match is displayed first on the list. You can enter multiple VFX reel names with 
wildcards, one per line, for simultaneous string matching. You can use whatever Reel Name 
text makes sense for your workflow, some examples of VFX reel names are as follows:

*_COMP_*

VFX*

EFFECTS*

5.  Click Continue.

 The ColorTrace window appears with two tabs that let you choose how to work.

6. Choose which mode to work in by clicking the Automatic or Manual tab:

 In Automatic mode, ColorTrace automatically searches for matching clips between the 
selected timeline and the current timeline. Each clip is color coded depending on the 
correspondence that’s been identified.

 In Manual mode, you copy grades yourself, using the Copy and Paste procedures, or by 
dragging and dropping using your mouse.

 The ColorTrace window is complex; details about the operation of each mode are covered 
separately in the following sections.

7. When you’re finished using ColorTrace, click Close.

Using ColorTrace in Automatic Mode

In Automatic mode, ColorTrace automatically finds the correspondences between clips in the 
selected timeline that you want to copy grades from (the Source timeline), and those in the current 
timeline that you want to copy grades to (the Target timeline).

Selecting the Automatic or Manual ColorTrace 
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Each clip in the Target Timeline Thumbnail timeline is outlined with a color that indicates its status.

 > Red: No match was found at all. 

 > Blue: Due to overlapping timecode and reel names, multiple correspondences have been 
found (similar to a reel conflict), and you must select the correct one for each clip.

 >Green: A perfect match has been found. 

ColorTrace Thumbnail outlines indicate matching, overlapping and non matching clips

In Automatic mode the correspondence between each clip in the Source timeline and each clip in 
the Target timeline should be automatically made. However, overlapping timecode and reel names 
can cause problems. The other controls in the ColorTrace window help you deal with the subset of 
clips that can’t be automatically matched, or are matched in error. These controls are:

The ColorTrace window shown in Automatic mode

 >Matching Source Clips list: Shows a scrollable collection of thumbnails that might correspond 
to the selected clip in the Target timeline.

 > Target Timeline: Shows each clip in the Timeline you want to copy grades to, color coded 
according to how good a match it is.

 > Clip Info pane: Displays two columns of properties for the source clip and the target clips 
that you’ve selected. These properties include the reel, source timecode, record timecode, 
clip name, project names, and timeline names of each clip, for easy comparison.

 > Attributes and options checkboxes: A series of checkboxes lets you specify which clip 
attributes are copied as part of the ColorTrace operation.

 > Color: Enables the copying of grades.
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 > Preserve Num Nodes: When copying grades, lets you prevent the first X nodes of the 
target clip grades from being overwritten by the first X nodes of the source clip grades.

 > Sizing: Enables the copying of Edit sizing attributes.

 > Input Sizing: Enables the copying of Input Sizing attributes.

 > Convergence: Enables the copying of Convergence for Stereo 3D projects.

 > Floating Windows: Enables the copying of Floating Windows for Stereo 3D projects.

 > Auto Align: Enables the copying of Auto Align settings for Stereo 3D projects.

 > All Versions: Copies all versions, rather then just the current version, from the source 
to the target clips. The currently selected version of each source clip is always 
correctly copied.

 > Version Camera Raw Settings: Enables the copying of versioned Raw settings, rather 
than just the current Raw setting.

 > Track Marks: Enables the copying of keyframes.

 > Hide Matching Clips: Hides all clips which have been successfully matched, and 
only show the clips with multiple or no matches. This lets you focus on the subset of 
problem clips within a potentially long Timeline.

 > Ignore Reel Names: If you believe the reel names are in error, you can turn this checkbox 
on to ignore them, matching all source and target clips by timecode alone.

 > Copy Grades: Copies the matched source grades to each green and purple target clip.

 > Copy Grades & Exit: Once you’ve finished making all the grade matches you can, click this 
button to copy the matched source grades to each green and purple target clip, and close 
the ColorTrace window.

Here’s how to use these controls to sort out which source clips to copy from for each blue and red 
target clip in the Target timeline.

To manually choose which source grades should be copied to which target clips:

1. Click any blue clip thumbnail in the Target timeline.

 A collection of clips with overlapping timecode and reel names appears. If you want to 
ignore the reel names because you believe they might be in error, turn on the Ignore Reel 
Names checkbox.
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2. If a comparison of the Source and Target thumbnails doesn’t make the choice obvious, then 
click any of the clips in the Matching Source Clips timeline to view its metadata for comparison 
in the source/target columns below.

3. Once you’ve decided on a clip correspondence, double-click the Matching Source Clip 
thumbnail you want to copy from. If no clip in the Matching Source Clip pane is a good match, 
double-click the “Set As New Shot” box.

 The Source and Target thumbnails both turn purple, to show that you’ve created a 
correspondence. 

Source and Target clip metadata for comparison

The matching Source and Target clips now both marked with purple outline

Revealing a number of different possible correspondences in the Matching Source Clips timeline
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 Continue working your way through every thumbnail with Blue and Red Xs until you’ve found 
matches for every clip in the Timeline for which it’s possible.

4. When you’re finished, click Copy Grades & Exit.

Using ColorTrace in Manual Mode

Manual mode is ideal for situations where you want to copy grades between programs with clips 
that have no timecode or reel name correspondence at all. The Manual ColorTrace interface is 
designed to let you move through two different timelines, either a clip at a time, or in matching 
multiples of clips, copying grades from the Source timeline to the Target timeline.

For example, if you’re trying to copy grades from a timeline that was conformed from individual 
media files, to another timeline that was conformed from a flattened master media file, you can use 
the ColorTrace Manual mode to accomplish this.

The manual interface consists of two sets of controls that correspond to the Source timeline (labeled 
“Timeline to copy from”), and the Target timeline (labeled “Timeline to paste to”). The general idea 
is that you move through both sets of timelines one clip at a time, or in matching multiples of clips 
at a time, and copy grades from the “Copy from” timeline to the “Paste to” timeline.

Manual mode has the following controls:

 > Copy Range controls: Two fields show the range of clips in the current selection that you’ll be 
copying from, referred to by their numeric position in the Source timeline. You can change 
the range numerically by either entering new numbers in the fields, or by using the up/
down arrow buttons to alter the value by one. The First button automatically adds all clips 
from the first one in the Timeline into the current selection. The Last button automatically 
adds every clip going to the last one in the Timeline to the current selection.

ColorTrace Manual window
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 > Source timeline: Shows all clips in the Source timeline you selected; the clips you’re 
copying grades from. Click any one clip thumbnail to select it, or click a thumbnail, and 
then shift-click another thumbnail to select a contiguous range of clips. You cannot select 
a noncontiguous range of clips.

 > Target timeline: Shows all clips in the Target timeline you selected; the clips you’re pasting 
grades to. Selecting clips works identically as with the Source timeline.

 > Paste Range controls: Two fields show the range of clips in the current selection that you’ll 
be pasting to, referred to by their numeric position in the Source timeline. All controls work 
identically to the Copy Range controls.

 > Attributes and options checkboxes: Turn off the checkboxes of any clip characteristics that 
you don’t want to copy as part of the ColorTrace operation. A more complete description 
of these options appears in the section on the Automatic ColorTrace mode.

 > Paste button: Once you’ve selected one or more source clips and a matching number of 
target clips, clicking Paste copies the grades, PTZR settings, and marks (depending on the 
corresponding checkboxes).

 > Undo Last: Lets you undo the most recent paste action.

 > Undo All: Lets you undo all paste actions in Manual mode.

 > Done: Finishes the operation and closes the ColorTrace window.

If you’re cherry picking individual grades from one timeline to paste into shots in another, you can 
copy grades one at a time.

To copy one source grade to one target clip:

 > Click a thumbnail in the Source timeline (on top) to copy from, then click a thumbnail in the 
Target timeline (on the bottom), and click Paste.

You can also simultaneously copy the grades of entire scenes of clips from one timeline to another. 
For example, if you’re copying grades from an originally graded timeline to a re-edited version of 
the same program, you can copy every grade from a 10-clip scene in the Source timeline to the 
same 10 clips in the Target timeline which have been pushed back later in the Timeline.

To copy a group of source grades to a group of target clips:

1. Choose a continuous range of source clips by doing one of the following:

 >  Click the first clip in the range, and then Shift-click the last clip in the range.

 >  Enter the clip number of the first clip in the left “Copy Range” field, and then enter the clip 
number of the last clip in the right field.

 >  Click a clip, and then click First to select every clip from that one to the first clip in the timeline.

 >  Click a clip, and then click Last to select every clip from that one to the last clip in the timeline.
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2. Choose a continuous range of target clips by using the same procedures as in the previous 
step, but using the “Paste Range” controls.

 Important: You must select the same number of target clips as you did source clips for the 
Paste button to become enabled.

Group copy and paste of grades

3. When you’ve made your selections, click Paste.

 The grade settings from the source clips are pasted to the destination clips, in order. In other 
words, if you copy from clips 27, 28, and 29 to clips 4, 5, and 6, then grade 27 is copied to shot 
4, grade 28 is copied to shot 5, and grade 29 is copied to shot 6.

Importing CDL Data Using ColorTrace

The ColorTrace CDL command lets you import ASC CDL file formats from other applications into 
DaVinci Resolve. Resolve version 11.1 also added the ability to read DRX filenames from CDL files, 
allowing a CDL to load exported Resolve grades.

There are three supported file formats:

 > CMX EDL: An EDL with comments referring to CCC/CDL XML files, or even Slope, Offset, 
and Power (SOP) data within the comment area.

 > CCC and CDL XML: A file format that contains various color correction looks, and even 
references.

To import CDL data into DaVinci Resolve:

1. If you’re importing CCC/CDL XML correction looks:

 >Open the Gallery page, right-click anywhere within the Stills tab, and choose “Import” from 
the contextual menu. 

 >When the Import Stills dialog appears, open the CDL/CCC files. When these are finished 
importing into the Gallery, an ASC logo will appear along with them.

2. Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline list.
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3. Right-click anywhere within the Timeline, and choose ColorTrace from CDL.

4. Select an EDL using the Select EDL dialog, and click Open.

5. Select its corresponding CDL and CCC files using the Select CDL Files dialog. If there are 
no CDL or CCC files (which is the case if there are inline SOP comments within the EDL), you 
should click cancel.

6. Using the ColorTrace With CDL window, copy the source grades from the CMX EDL/CCC & 
CDL XML files to the Target timeline.

 At this point, the ColorTrace window works identically as previously described.

For formatting reference, here are some examples of CMX, CCC and CDL files.

Example CMX EDL File
TITLE: Final EDL FCM: NON-DROP FRAME 010 001 V C 01:19:28:16 

01:19:28:16 01:00:41:18 01:00:42:18 *ASC_CC_XML test_cc.102 

011 001 V C 00:00:00:00 01:19:28:16 01:00:42:18 01:00:43:18 

*ASC_SOP (0.9 1.2 0.5)(0.4 -0.5 0.6)(1.0 0.8 1.5)

Example CCC File
<ColorCorrectionCollection xmlns:”urn:ASC:CDL:v0.5” >

<InputDescription> test corrections for ref_input_image.1920

</InputDescription> <ViewingDescription>

for mathematical analysis only </ViewingDescription>

<ColorCorrection id=”test_cc.100”> <SOPNode>

<Description> for ref_output_image.0100 </Description> <Slope> 1.0 1.0 

1.0 </Slope> <Offset> 0.0 0.0 0.0 </Offset> <Power> 1.0 1.0 1.0 </Power>

</SOPNode> </ColorCorrection>

<ColorCorrection id=”test_cc.101”> <SOPNode>

<Description> for ref_output_image.0101 </Description> <Slope> 1.0 1.5 0.6 

</Slope> <Offset> 0.0 -0.1 0.01 </Offset> <Power> 1.0 1.5 0.5 </Power>

</SOPNode> </ColorCorrection>

</ColorCorrectionCollection>
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Example CDL File
<ColorDecisionList xmlns=<94>urn:ASC:CDL:v0.5<94> >

<InputDescription> GeneralProducts M1 std thru GP M1 LUT4 </

InputDescription> <ViewingDescription> GP P1, DCI P3, Pathe 

color emul </ViewingDescription> <ColorDecision>

<MediaRef ref=<94>/some/Project/frame%250900-0954%5B.

dpx<94>/> <ColorCorrection id=”cc03340”>

<SOPNode> <Description>change +1 red, contrast boost</

Description> <Slope>1.2 1.3 1.4</Slope> <Offset>0.3 

0.0 0.0</Offset> <Power>1.0 1.0 1.0</Power>

</SOPNode> </ColorCorrection>

</ColorDecision> </ColorDecisionList>

Calculating CDL Functions

To turn the SOP values into a primary correction, the following math is used by DaVinci Resolve:

Output = (Input * Slope + Offset)Power

Output refers to the final grade. Input is the value of each pixel within each color channel (on a scale 
from 0-1). The detente value for Slope is 1. The detente value for Offset is 0. The detente value for 
Power is 1.


